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1 Introduction

Thank you for purchasing the SQM-LU-DL. You will soon be on your way to collecting scientific data.

The SQM series of products have been used in the following applications:

• Quantitatively comparing the sky brightness at different astronomical observing sites.

• Documenting the evolution of light pollution.

• Setting planetarium dome illumination to mimic the skies that people are likely to experience elsewhere in the city.

• Monitoring sky brightness through the night, night-to-night, and year-to-year for astronomical observation records.

• Determining which nights show the greatest promise for finding the ’faintest fuzzies’.

• Calibrating the effect of sky brightness on qualitative measures such as the Bortle Scale or NELM.

• Investigating how sky brightness correlates with the solar cycle and month-to-month sunspot activity.

• Helping to provide local ground truth for future sky brightness prediction with the Clear Sky Clock.

• Helping CCD users make a correlation between the SQM reading and when the background reaches some ADC
level.

• Assisting Sea Turtle researchers in studying the amounts of light in areas where turtle hatchlings are affected by
artificial lights.

• Researching bird-song synchronization with dawn.

• Researching twilight brightness changes with the addition of external Neutral Density filters. Unihedron offers
adapters to attach such filters onto the meter.

• The SQM-LU-DL has the same features as the SQM-LU with the addition of data logging capabilities.

1.1 QuickStart

1.1.1 Setting up the instrument

1. Connect the SQM-LU-DL meter to the computer with the supplied USB cable. Wait for any device drivers to
automatically load (if required). You may have to visit www.FTDIchip.com to get the latest VCP drivers if they
do not get installed automatically.

2. Ensure that your computer date and time is up-to-date.

3. Install and launch UDM (Unihedron Device Manager software supplied on the CD from your File Manager).

4. Click the “Find” button to find attached devices, then click on the SQM-LU-DL that you connected.

5. Click ”Data Logging” tab to go to the setup page.

6. Click the “Set” button in the “Device Clock” area on that page to synchronize the SQM-LU-DL internal time with
your computer time and date.

7. Set the repetition time for the readings in the “Trigger” section on the left side of the window. A good rate is “every
5 minutes”.

8. Keep the SQM-LU-DL connected to the computer for a couple of hours to charge up the internal Supercap; this
allows it to keep the time and date clock running while you are moving from your computer to the measurement
site. A fully charged meter will keep the clock running for a few days unpowered.

9

http://www.FTDIchip.com


1 Introduction

9. Disconnect the SQM-LU-DL from the USB cord and plug in the battery pack within eight hours, the LED will come
on for three seconds to indicate that the unit woke up and is working. The LED will come on every minute for a
few seconds, you can use this to determine if the unit is still properly powered. Note: beware that using a “USB
charger” instead of the battery pack may cause problems since some of these chargers make the SQM-LU-DL think
it is connected to a computer instead of a battery, and some other chargers do not have the surge capacity to allow
the SQM-LU-DL to start up properly.

The device is now recording.

1.1.2 Saving the data log

Follow these steps to retrieve the logged data from the SQM-LU-DL:

1. Connect the SQM-LU-DL to the computer with the USB cable.

2. Launch the UDM program and find your device as before.

3. Select the “Data Logging” tab.

4. Click “Retrieve All” and follow the instructions on that page.

5. ONCE YOU’VE CHECKED THAT THE DATA IS SAVED TO DISK PROPERLY, and you want to clear the
data-logger memory in preparation for a new set of records, you can erase the old memory. Warning this step
cannot be undone!

1.1.3 Getting the data from the data log into MS Excel

1. Find the log data. It will be in a *.dat file, where the * will give you the date and time

2. In the Tools pulldown in the UDM program, use the “.dat to Moon .csv” function to convert the log file to a *.csv
file. Do not erase the original log file, because it contains some information (e.g., the type and serial number of your
SQM) that is not converted to the csv file.

3. Open the *.csv file in Microsoft Excel.

4. In Excel, highlight the data, then in the “Data” pulldown, use the “Text to Columns” function to convert the data
into columnar format; the divider is a semicolon.

5. Your data is now in nice columns by date and time, so you can plot it out as you wish.

1.1.4 Other software

• If you are using Windows, you may want to use Knightware SQM-Reader from www.knightware.biz/sqm .

• The CD contains examples of software (Perl, Python, etc.) for various functions that connect to the meter.

1.1.5 FITS integration

Some programs (listed below) gather information from the Unihedron Sky Quality meter products and insert that data
into the Flexible Image Transport System (FITS) header.

• MaxPilote (Freeware) incorporates SQM readings from an SQM-LE/SQM-LU into the FITS header while at the
same time provide constant readings in a live and updated Data Window.

• CCDAutoPilot

• FITS4Win2 uses the MPSAS keyword for sorting and filtering image files.
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2 Measurements

The SQM-LU-DL provides readings in Magnitudes per square arcsecond, abbreviated as: mpsas, and written mathemat-
ically as mag

arcsec2 .
Mpsas is a logarithmic measurement which means that large changes in sky brightness correspond to relatively small

numerical changes. A difference of 5 magnitudes is a factor of 100 times the intensity. Therefore a sky brightness 5.0 mag
arcsec2

darker corresponds to a reduction in photon arrival rate of a factor of 100.
The following schematic gives a rough idea of how to interpret the readings of the SQM:

Figure 2.1: Mpsas interpretive scale

Magnitudes are an astronomical unit of measure for object brightness. Brighter objects have a lower magnitude and
darker objects have a higher magnitude value. For example; a star that is 6th magnitude is brighter than a star that is
11th magnitude.

The star Vega is used a the reference point of ≈ 0 magnitude. Table 2.1 shows the apparent magnitude of some common
known celestial objects.

Table 2.1: Apparent Magnitudes of Known Celestial Objects adapted from [2]

App. Mag. Celestial Object

−26.73 Sun

−12.6 full Moon

−4.7 Maximum brightness of Venus

+0.03 Vega, the original zero point

+6 Faintest stars observable with naked eye

+27
Faintest objects observable in visible light with 8m ground-based tele-
scopes

+30
Faintest objects observable in visible light with Hubble Space Tele-
scope

Arcsecond is the definition of an arc being divided up into seconds as follows.

1. There are 360 degrees in a circle.

2. There are 60 arcminutes in a degree, and 21600 arcminutes in a circle.
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3. There are 60 arcseconds in an arcminute, and 1296000 arcseconds in a circle.

Square arcsecond (arcsec2) is the area covered by a square measuring 1arcsec× 1arcsec .

Magnitude per square arcsecond is the definition of brightness in magnitudes spread out over one square arcsecond
of the sky. For example; if the SQM provides a reading of 20.00 mpsas, that would be like saying that a light of a 20th

magnitude star brightness was spread over one square arcsecond of the sky.

The ”magnitudes per square arcsecond” numbers are commonly used in astronomy to measure sky brightness. More
details can be found at www.stjarnhimlen.se/comp/radfaq.html

Each magnitude lower (numerically) means just over 2.5 times as much more light is coming from a given patch of sky.
A change of 5 mags/sq arcsec means the sky is 100x brighter.

The darkest we’ve personally experienced with the SQM in a natural clear sky was 21.80.

2.1 Getting accurate readings

Various factors will cause the night sky brightness to fluctuate. Taking more readings will be useful in ruling out spurious
events. The SQM gathers light for at least a one second period, and the brightness report is based on the light that was
accumulated during that time.

At the darkest sites, natural variations in conditions such as airglow and the brightness of the zodiacal light are limiting
factors.

Prevent artificially high (dark) readings by ensuring that there is nothing blocking the view of the sensor. Avoid taking
readings near trees or buildings that may block the sensor.

A reading of greater than 22.0 is unlikely to be recorded, however there are reasons for extra dark readings:

• Cloud or ash covered sky in a remote area where little natural sky brightness can be recorded.

• Uncorrected readings from covered meter like a weatherproof housing.

• Obstructed view like inside a forest, or where large buildings are located within the field of view, or a person or bird
blocking the view.

When the sky is very dark, the meter takes longer to gather enough light to produce a reading. During this time
of light gathering, the reading will remain constant until the meter can start gathering readings fast enough for new
reading-requests.

The readings are averaged in an 8-cell rolling buffer, so it may take a while for the meter to produce a new value of
darkness when obstructions leave the field of view.

Prevent artificially low (bright) readings by ensuring that there are no lighted objects (street lamps, the moon, etc.)
that shine into the sensor at any angle.

2.1.1 Seeing conditions

Scintillation is due to refractive changes in the atmosphere caused by temperature changes at differing heights.

Stars are too small in comparison to the entire SQM field of view, so scintillation is not expected to alter the SQM
reading significantly.

2.1.2 Light pollution

Undesirable artificial light that reaches you is considered to be light pollution. Much of this light comes from outdoor
illumination of parking lots, street lamps, office buildings, advertising signs, etc..

Other causes of extra light in the night sky are listed below:
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2.1 Getting accurate readings

Aurora

Charged particles emitted from the Sun are directed to the poles of the earth by the Earth’s magnetic field. These particles
collide with atoms in the atmosphere and cause light to be emitted. Aiming the meter at the polar regions during Aurora
Borealis (in the North) or Aurora Australis (in the South) will reduce the reading (lighter). Aiming the meter towards
the equator will increase the reading (darker) under these conditions.

Airglow

Airglow is light produced by various phenomenon in the atmosphere which prevent the sky from being totally dark. Effects
of the magnetic poles of the Earth may cause airglow to be brighter near the poles.

The Milky Way

As one goes to sites with darker surface brightnesses, the fraction of the total light received by the SQM-LU-DL which
can be attributed to the Milky Way bulge increases and so the “offset” in mpas will be larger (due to the Milky Way.)

The northern view of the Milky Way contributes about 0.10 mpsas under 21.5 mpsas (moonless) skies.
The southern view of the Milky Way might be as big an effect as 0.56 mpsas in dark skies where it goes near-overhead.
For more information, see Surface Photometries of the Milky Way (Schlosser+ 1997)

vizier.u-strasbg.fr/ftp/cats/VII/199/ReadMe

Moisture

Clouds, fog, and mist will reflect artificial light back down to the Earth causing a brighter (lower) reading. If there is
no artificial light, then clouds may prevent starlight from coming to you and the reading will be darker (higher). This
extra-dark situation can occur in very isolated areas like mountain tops, the ocean, or the desert. You will have to be
aware of this special situation when analyzing readings.

Volcanic eruptions

Dust released into the atmosphere by volcanoes can reflect light from the surface of the earth back down. In a dark
location this dust will prevent the light from stars and Milky Way and produce a darker (higher) reading.

Zodiacal light

The sunlight reflected of off dust particles in the ecliptic plane of our solar system is called zodiacal light.
The amount of light will be different depending on whether the meter is pointed to the poles or plane of the solar

system. It is likely to have less than 2% effect. The primary reason for this small effect is that the brightest and widest
part of the zodiacal light is nearest the horizon where the SQM has almost no sensitivity (due to it being a primarily
zenith-looking device). The portions at higher altitude are the narrowest and faintest and they would barely creep into
the sensitivity cone of the SQM.

2.1.3 Other luminance scales

Candela per square meter (cd/m2) is commonly used by lighting engineers.
To convert the SQM mpsas reading to cd/m2, use Equation (2.1):

[cd/m2] = 10.8× 104 × 10(−0.4×[mag/arcsec2]) (2.1)

Naked eye limiting magnitude (NELM)
Quite often astronomers will refer to a sky by the darkest star they can see, for example a “6th magnitude sky”, in that

case you can see 6th magnitude stars and nothing dimmer like 7th magnitude stars. The term “6th magnitude skies” is
very subjective to a persons ability to see in the night, for example an older person might say “5th magnitude skies” but
a young child with better night vision might say “7th magnitude skies”.
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2 Measurements

Nobody has performed the task of defining a relationship between the two methods of sky brightness ( x magnitude
skies and magnitudes per square arcsecond) -- probably because one is subjective and the other is objective and a wide
variety of people would have to be polled.

An approximation exists for the conversion between NELM and MPSAS. You can use an NELM converter[5] created
by SQM user K. Fisher to do that conversion, or the chart shown in Figure 2.2 and Equations (2.2) and (2.3).

Figure 2.2: Mpsas vs NELM

Convert NELM (V mags) to MPSAS (B) sky brightness [3]

Bmpsas = 21.58− 5× log(10(1.586−NELM/5) − 1) (2.2)

Convert MPSAS (B) sky brightness to NELM (V mags) [4]

NELM = 7.93− 5× log(10(4.316−(Bmpsas/5)) + 1) (2.3)

NSU

A newly proposed term to define “Natural Sky Units”:

14 Unihedron SQM-LU-DL Operator’s Manual - 20190611



2.1 Getting accurate readings

In “natural sky units” (radiance relative to an assumed natural radiance of 21.6 magSQM/arcsec2 , see
methods), the range was 0.22 - 2200 NSU. Before the introduction of anthropogenic light, the radiance of a
patch of sky near zenith on moon-free nights is likely to have been nearly always within the range 21 (galactic
center near zenith) to 24 mag/arcsec2 (very thick clouds), or 0.1 - 1.7 NSU.[1]
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3 Theory of operation

Figure 3.1: SQM-LU-DL Block diagram

3.1 Light measurement

The SQM-LU-DL measures the darkness of the night sky to provide readings of magnitudes per square arc second through
the USB connection.

A light to frequency sensor (TSL237) provides the micro-controller with a signal whose frequency depends on the
amount of incoming light. And, readings from the temperature sensor are used to compensate the light sensor readings
through the range of operating temperatures.

In bright skies, the sensor produces a high frequency square wave (up to 500kHz). As the sky gets dark, the sensor
produces a low frequency. In absolute darkness, the sensor period is very long, and is defined on the calibration sheet as
“Dark period” with a 300s timeout.

Measurement of this wide range of frequencies is done by timers and counters inside the microprocessor. It is difficult for
a microprocessor to accurately measure the period of high frequency signals, and just as difficult to measure the frequency
of extremely low frequency signals. For this reason the microprocessor has two modes of signal measuring:

Frequency mode: The frequency mode is for bright readings where the frequency is high. The sensor signal is fed
into a counter that is gated at one second intervals to report a frequency measured in Hz.

Period mode: The period mode is for dark readings where the frequency is low. The sensor signal gates a high
speed internal counter which reports the period measured in µs.

Both Frequency and Period results are available when connected directly to the meter and using the “rx” command.
The SQM-LU-DL computes mpsas by deciding if the period or frequency report should be used and then compensating

for temperature. Deciding between period or frequency mode reporting was originally done at a frequency of 354Hz, but
by selecting the “Ideal crossover firmware” setting on the “Report interval” page, the switchover will be 679Hz which
offers the best resolution at the switchover point.

The SQM-LU-DL holds the updated period and frequency recordings in memory while waiting for an asynchronous
user request for a reading. It is possible for the user to see stale readings if the light sensor cannot gather enough light
to produce a reading before the user asks for the next report (i.e. using the “rx” command too frequently). Starting at
firmware version 58, the SQM-LU-DL can provide a status of the reading that the user has requested by using the “r1x”
command which contains a status suffix character of F/P/S whose meaning is:

F: fresh FREQUENCY mode reading.

P: fresh PERIOD mode reading.

S: STALE reading indicates that this reading has not changed since the last reading because there was not enough
light gathered to produce a new reading.
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3.2 Communication to the PC

3.2 Communication to the PC

Commands sent from a PC through the USB cable to the USB interface are relayed to the micro-controller.
The micro-controller responds to commands by sending data strings to the USB interface which are then relayed to the

PC.
Readings are gathered asynchronously by the micro-controller. Requests from the PC are buffered and dealt with as

time permits.
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4 Specifications

USB connection USB B connector.
5m USB A to USB B cable supplied.
USB FTDI VCP driver, serial port emulator at 115200baud.

Physical Size 5.5” x 2.6” x 1.1”

Meter weight 110g

Battery pack with batteries weight 160g

USB cable weight 140g

Meter precision Each SQM-LU-DL is factory-calibrated. The absolute precision of each meter
is believed to be ±10% (±0.10 mag/arcsec2). The difference in zero-point
between each calibrated meter is typically ±10% (±0.10 mag/arcsec2)

Field of View The Half Width Half Maximum (HWHM) of the angular sensitivity is ≈ 10◦.
The Full Width Half Maximum (FWHM) is then ≈ 20◦. The sensitivity to a
point source ≈ 19◦ off-axis is a factor of 10 lower than on-axis. A point source
≈ 20◦ and ≈ 40◦ off-axis would register 3.0 and 5.0 magnitudes fainter,
respectively.

Power requirement 18mA (from the 5V USB connection). Can be put to sleep and woken up
for battery operated data logging.
3.42V minimum under battery operation.
The included battery adaptor can handle up to 30VDC.

Operating temperature range -40◦C to 85◦C

Temperature Accuracy ± 2◦C maximum at 25◦C

Temperature update rate 4.3 seconds, 256 samples taken at 60Hz then averaged.

Data logging capacity 1MB Flash chip, 32 bytes per record= 32768 records total.
Newer firmware uses 16 bytes per record for 65536 records total.
Extended memory version (special order): 1048576 records total.
For actual memory capacity; see back label (no entry = 32768 records) or
UDM datalogger page while connected to the meter.

Real Time Clock accuracy +1.73s/day @25◦C, -2.27s/day @50◦C, per Citizen crystal
CFS206-32.768KDZB-UB
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4 Specifications

Figure 4.1: Front and back of of unit
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5 Hardware connections

The SQM-LU-DL requires one connection to a USB hub or a PC for configuring the device and recovering the readings
as shown in Figure 5.1.

Figure 5.1: Wired connection

The maximum length cable per the USB specification is 15ft (3m). USB extenders exist on the market, some work up
to 198ft (60m).

A battery adaptor with batteries is supplied to allow the SQM-LU-DL to perform data-logging while disconnected from
the computer. This battery connection replaces the USB connection from the computer as shown in Figure 5.2.

Figure 5.2: Battery connection

5.1 Battery operation

The SQM-LU-DL may be operated by an external battery using the supplied “battery to USB adaptor”. The lifetime of
the battery can be determined as shown below. This calculation is also performed and displayed by the UDM software
on the “Data Logging” panel. Figure 5.3 shows experimental results of the current profile using a 10Ω current shunt.
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5 Hardware connections

Current consumption values:

IQ = 209uA Quiescent current (5.1)

IW = 10mA Wake current (5.2)

IM = 55mA Measure current (5.3)

Current consumption timing:

tQ = 1− (tW + tM ) (5.4)

tW =
3s

60s
(5.5)

tM =
5s

n× 60s
(5.6)

n = number of minutes between samples (5.7)

Current consumption formula:

IAvg = tQ × IQ + tW × IW + tM × IM (5.8)

Figure 5.3: Current profile

As an example for determining battery life of a 3AH battery with sampling every 5 minutes:

TBatt =
AHRating

IAverage
(5.9)

=
AHRating

(IQ × tQ + tW × IW + tM × IM )
(5.10)

=
3AH

(209uA× 0.93̇ + 3s
60s × 10mA+ 5s

5×60s × 55mA)
(5.11)

= 1861 hrs, or 78 days, or 2.5 months (5.12)

Note that measuring is still performed for ”Threshold” settings, even when it is too bright to record a reading. Measuring
is performed to determine this ”measure” state, and IMeasure still applies.

5.2 Diagnostic LED

When the unit is connected to a battery, the red LED near the USB connector will illuminate in the sequence shown in
Figure 5.4 (firmware feature version 26 onwards):

22 Unihedron SQM-LU-DL Operator’s Manual - 20190611



5.2 Diagnostic LED

Figure 5.4: Diagnostic LED timing diagram

Description of LED flashes:

A On for three seconds during the power-up/boot-load sequence. During this time, the unit is supplying power to the
sensor components and will also accept firmware updates.

B Log a reading if it is scheduled and is above the set threshold. The meter requires about 8 seconds to gather a valid
reading, Some readings may take much longer (300s max) to acquire.

C Shutdown: One quick flash for normal battery voltage (above 4.9V), more quick flashes if the battery voltage is too
low (2:4.8V, 3:4.6V, 4:4.4V, 5:4.2V, 6:4.0V). Battery voltage detection is performed at the end of the light meter
reading time (B) because low batteries drop during power drain and this is the voltage that the light meter reading
was recorded at.

D Wake from sleep at the minute mark to check if a recording should be logged. The LED comes on bright then fades
off within one second. Firmware before feature 49 had this step leave the LED on for three seconds solid.

E Same as step C.
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6 Software development

The SQM-LU-DL uses the FTDI FT232R chip to communicate as a standard serial port device at 115200 baud using
the FTDI software drivers which are available for all major operating system platforms. Drivers are available from
www.ftdichip.com .

Once the driver is installed, commands can be sent to the SQM-LU-DL using a serial terminal emulator to the serial
communications port that the device routes to.

When connecting the SQM-LU-DL to a PC where the FTDI device driver is loaded, the serial port label will be
determined at connection time.

Each SQM-LU-DL has a unique serial number usually with a prefix of “FT........”. This serial number can be used to
identify the exact SQM-LU-DL device from other USB devices.

6.1 Writing your own software interface

All of the commands and responses of the SQM-LU-DL are documented in Section 8.

To communicate with the SQM-LU-DL, the following general steps are required:

1. A serial 115200 baud connection must be made to the serial port assigned to the SQM-LU-DL.

2. Data commands are sent to the SQM-LU-DL, and it responds with a string of characters.

3. Close the serial port so that other programs can access the SQM-LU-DL. Note: Only one connection can be made to
the SQM-LU-DL at a time. Therefore leaving a connection open constantly prevents other connections from being
made.

Various examples of reading from the SQM devices are supplied on the CD and available at the Unihedron website.
Below is an example using Perl to read the SQM USB device:

Listing 6.1: Read SQM-LU using Perl

#!/usr/bin/perl

#Filename: read-sqmlu.pl

#Description: Utility to read Unihedron Sky Quality Meter-LU (USB model)

# Define the required module

use Device::SerialPort;

# Open and configure serial port

$port= Device::SerialPort->new("/dev/ttyUSB2");

$port->user_msg(ON);

$port->baudrate(115200);

$port->parity("none");

$port->stopbits(1);

$port->databits(8);

$port->handshake("none");

$port->write_settings || undef $port;

$port->read_char_time(1); # Wait for each character

# Send request to SQM

$port->write("rx\r");

# Get response from SQM

($count,$saw)=$port->read(255);
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6.2 Pascal

# Close the port so that other programs can use the SQM

$port->close;

# Print the SQM result to the screen

printf("%s", $saw);

The above program prints a result like this:
r,-09.42m,0000005915Hz,0000000000c,0000000.000s, 027.0C

6.2 Pascal

The UDM program contains many examples of finding the SQM devices and reading data from them. It is open source
and written in Lazarus/FreePascal. The source files for UDM are available here:

unihedron.com/projects/darksky/cd/udm/ .
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7 Unihedron Device Manager

The Unihedron Device Manager (UDM) program is intended for use in maintaining and testing the Unihedron connected
Sky Quality Meter products. Windows, Mac, Linux versions of UDM area available on the supplied CD. It is used to:

• Read version information.

• Request readings.

• Read and set calibration data.

• Read and set all other meter parameters.

• Install new firmware.

• Setup and retrieve data from datalogging meters.

• Continuously log data from connected meters.

7.1 Getting UDM

UDM is supplied on the CD that shipped with the SQM-LU-DL. The latest version of UDM is available at the Unihedron
website at this location

www.unihedron.com/projects/darksky/cd/

7.2 Installation

7.2.1 System requirements

The UDM is a fairly simple (but large) program which should run sufficiently on any present-day computer under the
Windows, Mac, or Linux operating systems.

The Windows version of UDM can also be run in a virtualization mode using VMware Fusion. Access to the network
is achieved by the menu Virtual Machine > Network Adapter > Bridged (Autodetect) being checked.

7.2.2 Windows

The Windows version of UDM is in a setup.exe style file located in the Windows subdirectory of the CD, for example:
\Windows\setup1.0.0.38.exe
Simply double-click on that file to start the installation procedure.

7.2.3 Mac

The Mac OSX version of UDM is a dmg file located in the Mac subdirectory of the CD, for example:
/Mac/udm.app.dmg

Drag the app to the /Applications directory.

7.2.4 Linux

The Linux version of UDM is available in a Debian package separately for both 32bit and 64bit systems located in the
Linux directory of the CD, for example:
/Linux/udm 20140821-1 i386.deb

Open the file with package installer program like GDebi.
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7.3 Operation

7.3 Operation

After starting UDM, a list of found devices should appear, if your device is not listed on the screen, try clicking “Find”
once more to search for connected devices.

If more than one SQM device is found, then you will have to select (click) on one of the devices, otherwise if only one
device is found, then click on “Version” or “Reading” of the information tab for more information.

The tabs can be used to select various functions when working with your selected device. These tabs and their functions
are described further in this document.

7.3.1 Start up

After starting the UDM program, a splash screen shown in Figure 7.1 is temporarily shown while the program searches
for attached devices.

Figure 7.1: Splash screen

1. UDM searches for attached USB devices first. This step is fairly quick (a few seconds).

2. UDM then searches for attached Ethernet devices within the reach of the Ethernet network but not outside a firewall.
This step may take about 30 seconds.

If no devices are found, then the main UDM program will be shown with the “found devices box” empty. You can
attach an SQM device to your computer and press the “Find” button to search for the newly connected devices.

If you know that an Ethernet device is connected but it does not show up, then a network problem may be the cause.
Also check the power connection to the SQM-LE.

If you know that a USB device is connected but it does not show up, then there may be a device driver issue. Check
the USB device listing for your operating system. These USB devices should appear as a COMM port. Also, check the
troubleshooting notes in section 13 on page 88 for possible solutions.

7.3.2 Main screen

The main screen of UDM consist of the following sections:
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7 Unihedron Device Manager

1. Window controls

2. Menu

3. Found devices box

4. Selected device details

5. Information section

6. Status bar

7.3.3 Main menu

The main menu of UDM consists of the items; File, View, Tools, Help as defined below.

7.3.4 File menu

The file menu is used for: opening files, finding newly attached devices, and quitting the program as shown in Figure 7.2.

Figure 7.2: File menu

File : Open

The “File : Open” menu item is used to open up previously stored log files or calibration reports.
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7.3 Operation

Figure 7.3: File Open dialog

File : Find USB

The “File : Find USB” function can be used to only find attached USB devices and ignore possible Ethernet devices. The
hotkey Ctrl+U can also be used instead of the mouse.

File : Find Ethernet

The “File : Find Ethernet” function can be used to only find attached Ethernet devices and ignore possible USB devices.
The hotkey Ctrl+E can also be used instead of the mouse.

File : Quit

The “File : Quit” menu item is used to close the UDM program.
The program can also be closed from the window panel “X”.

7.3.5 View menu

The view menu allows you to enable various tabs and check other settings of the UDM program.

Figure 7.4: View menu

View : Simulation

Click on “View : Simulation” to toggle visibility of the “Simulation” tab. The Simulation tab can be used to send requests
to the SQM-LU-DL to simulate conversions of frequency and period to light meter values. See page 55 for more details.
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7 Unihedron Device Manager

View : Configuration

Click on “View : Configuration” to toggle visibility of the “Configuration” tab. The Configuration tab is used to configure
the SQM with its calibration values when calibrated light and dark settings are being performed.

View : Log shows a window of commands and responses sent to and received from the SQM during this session of
running UDM. Some excessively repetitive commands are suppressed from this listing.

Figure 7.5: View : Log

View : Directories shows the directory paths used by UDM to store and retrieve data.

Figure 7.6: View:Directories

Logs Directory Path shows the path where logged records are kept. These logged records are created when using the
“Log one Record” or “Log Continuously” features. Also, log files from data-logging meters will be stored here from the
“Retrieve All” function.

The “Logs Directory Path” path can be changed from its default by pressing the folder button the right. After the
path has been changed, new log files will be stored in that new folder.

TZ database path The Time Zone information is required for datalogging purposes because the timestamp is logged
as UTC. Since time zones change over the years, the entire Time Zone database is required and hence distributed with
UDM and stored at the displayed “TZ database path”. This path is not changeable.

The Time Zone database is taken from: http://www.twinsun.com/tz/tz-link.htm

Firmware files path The firmware for the SQM-LU-DL can be updated or reverted using UDM. These firmware files are
stored at the displayed firmware files path. This path is not changeable.
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7.3 Operation

Data Directory is the place where some data files are kept, specifically the change-log for UDM and firmware files. This
path is not changeable.

Configfile path is the place where UDM stores its configuration about the program and attached SQM devices. This
path is not changeable.

View : DL Header shows the Data-logger header editing page. See the information at www.darksky.org/measurements
for a detailed description of each field.

Figure 7.7: Data logging header
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7 Unihedron Device Manager

DL : Position can be changed by pressing the Edit button which calls up the following dialog:

Figure 7.8: Set Location dialog

The “Set location” dialog is used to type in your location and have it verified on the world map. Use the following
steps to set the location:

1. Type the exact location coordinates (in degrees) of the SQM-LU-DL into the “Desired” fields.

2. The mouse pointer can be used to select an approximate location if you are not sure of the exact coordinates.

3. The “Elevation” entry is optional as it is not used for anything yet.

4. Press the “Apply” button when you are satisfied with the desired values. Note: The “Apply” button will only be
enabled if there is a difference between the desired and actual values.

5. Press “Close” when you are satisfied with the actual values.

The “Local timezone region” and “Local timezone name” are required by UDM to calculate local times of the recorded
data before storing to disk. UTC timestamps are stored in the SQM-LU-DL.

The cover offset is a text only field that indicates what offset was used on the calibration data of the SQM-LU-DL.
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7.3 Operation

View : Plotter The plotter window can be used to analyze .dat files recorded by UDM. An example shown below:

Figure 7.9: Plotter window

• The left sidebar tab be expanded and contracted by cliking on the tab title bars.

• Many data points can be optionally included from the “Settings” tab.

• The plotter can also calculate and display rise/set lines for the Sun.

• The “Help” tab shows some hints for zooming and also the line color definitions of plotted lines.

• The bare plot can be saved in vector graphics (SVG) or bitmap (PNG) modes using the “Save” buttons in the
“Settings tab”.
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7 Unihedron Device Manager

7.3.6 Tools menu

Tools : old log to dat

The “old log to dat” tool is used to convert the original .log files that UDM created before the .dat file was made standard.
Figure 7.10 shows the setup dialog for conversion.

Figure 7.10: Tool : old log to dat

Tools : dat to Moon csv

The “dat to Moon csv” tool is used to convert .dat files to a csv file that contains Moon data using algorithm library
from Andreas Hörstemeier [6]. This tool prepares the file for importation into a spreadsheet like Excel, OpenOffice, or
LibreOffice. For importing into a spreadsheet.

The value for “Moon phase angle” reported in the .csv is:

• 180 or -180 = Full Moon

• 0 = New Moon

• Positive numbers Waxing (growing)

• Negative numbers Waning (shrinking)

Figure 7.11: Tool : dat to Moon csv

Press the “Select ...” button shown in Figure 7.11 to select the file and start the conversion process.

You may also be interested in the “Excel import” instructions listed in section 7.5.1.
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7.3 Operation

Tools : Comm terminal

The “Comm terminal” is a communication terminal window used for sending manual commands and viewing the response
of the selected (from the found devices window) device.

Figure 7.12: Tool : Comm terminal

Tools : DL retrieve

The “DL retrieve” tool is used for datalogging and Vector model to pull in data files that were stored on disk previously.

Tools : .dat to .kml

Creates a .kml file from a .dat file. This is used when the SQM-LU-DL and an external GPS are read by UDM in the
Log Continuous datalogging mode.

Figure 7.13: Tool : .dat to .kml

The .kml file can be imported into GoogleEarth to create an image similar to this:
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7 Unihedron Device Manager

Figure 7.14: Tool : .dat to .kml GoogleEarth result

This tool uses a legend image (kmllegendnewatlas.png.png or kmllegendcleardarksky.png) which must be available to
GoogleEarth to properly display the legend. The resultant .kml file and legend file is stored in the “Logs directory path”.

A minimum set of data can be used by UDM to produce a map with only the MSAS brightness, Latitude,Longitude.
The timestamp

The data file (with .dat extension) requires a definition line which contains at least the following fields:
# UTC Date & Time,MSAS,Latitude,Longitude

A minimum example of a data file showing three data records:

Listing 7.1: .dat minimum field example

# UTC Date & Time,MSAS,Latitude,Longitude

2018-02-07T04:27:57.642;19.0;33.2208;-116.3387

2018-02-07T04:28:17.089;18.3;33.2208;-116.3422

2018-02-07T04:28:37.105;18.0;33.2210;-116.3457

The UTC Datestamp data is not used to make the .kml file, but UDM requires something there.
The format of the fields are:
# YYYY-MM-DDTHH:mm:ss.fff;mag/sqarcsec;Degrees;Degrees

Tools : .dat time correction

Corrects a .dat file for out of synch timing by a manually entered offset. See figure 7.15.
This may be useful when the battery has expired in the datalogging meter, or if the clock was not set at the beginning

of the datalogging session.

Figure 7.15: Tool : .dat time correction

Select the .dat file for correction.
Enter the manual time offset correction (in seconds).
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7.3 Operation

Press the “Correct .dat file” button to write the corrected file to disk. The location of the new file is shown in the
bottom Filename section.

Tools : .dat reconstruct local time

If the datalogger timezone was not set properly, This tool can be used to recreate the local time values in the .dat file.

Figure 7.16: Tool : .dat local time reconstruction

Select the desired .dat file to reconstruct.

Select the proper region and time zone.

Press the “Reconstruct .dat local times” button

The reconstructed file will be written to disk at the location specified in the bottom Filename section.

Tools : .dat time correction

7.3.7 Help menu

Figure 7.17: Help menu

Help : Cmdline Info shows the commands that can be used when starting UDM from the command line.

Help : Version Info shows the detailed version information for the UDM software.

Help : About displays a simple screen with the version identifier.
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Figure 7.18: Help : About

Found devices box shows all the connected SQMs available that UDM can find from this computer.

If only one device is found, then UDM auto-selects it and gathers the version information for that selected device.

Figure 7.19: Found device (single)

If more than one device is found, then UDM does not select any of the devices. You may select the desired device by
clicking in the found devices box on the SQM that you want to know more about. Once you select the device, then the
connection details are displayed. Clicking on the “Version” or “Reading” button will gather more information from the
meter.

Figure 7.20: Found device (multiple)

Device details shows the connection details of the selected SQM listed in the “Found devices” box.

The USB “Port” field is editable so you may enter your own port that might not be defined in the found box. See
Figure 7.21.

38 Unihedron SQM-LU-DL Operator’s Manual - 20190611



7.4 Information tab

Figure 7.21: USB connection details

The Ethernet IP and port fields are editable so you may enter your own IP and port that might not be defined in the
found box. The default port number for the SQM-LE is 10001. See Figure 7.22.

Figure 7.22: Ethernet connection details

The RS232 fields are editable so you may enter your own port and baud rate. The baud rate for the SQM-LR is 115200.
See Figure 7.23.

Figure 7.23: RS232 connection details

7.4 Information tab

The information tab is used to show information about the version and the reading of the selected SQM.
Press the “Version” button for an updated list of data about the device version, and press the “Reading button” for

an updated list of data about the device reading.

Figure 7.24: Information tab

The Header button calls up the data file header entry screen, see the datalogging Header section on page 31 for more
information. This header information is used when storing logged data to the disk with the “Log one record” or “Log
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continuous” functions described below.

Log one record gathers one data record from the connected SQM and stores that information to a data log file on the
disk in the “Logs directory path”. The location of the file can be identified and changed by “View : Directories”. The log
file can be accessed later from the “File : Open” menu.

7.5 Log Continuous

The “Log continuous” function allows data from the connected SQM device to be logged repetitively as shown in Figure
7.25.

Figure 7.25: Log Continuously screen

Log Continuous Trigger options must be defined before logging, see Figure 7.26 for possibilities:

Figure 7.26: Log Continuously Trigger tab

To operate the continuous logging function:

1. Select the frequency of logging from the trigger tab.
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2. Select if Moon data is to be computed and logged.

3. Select if moving data is to be recorded, specifically records unaveraged values and Fresh/Stale results.

4. Select a limit to the number of records. A value of zero is default and means there is no limit. Any other value
1-1000 means that UDM will stop recording after that many records have been taken.

5. Press the “Record” button. The records are stored in a logfile whose location is shown in the “Logfile name” area.
A new logfile is automatically created at the beginning of each day (at local time 0:00).

6. Press the “Stop” button when you want to stop the recording process.

7. Log files can be accessed by the “File : Open” menu selection or by pressing the “folder” button shown in the “Log
Continuously” screen.

8. Press “Close” when done with the continuous logging feature.

Threshold to record A threshold for recording readings can be set before starting recording. Any reading greater or
equal to this threshold value will be recorded in the log file.

Figure 7.27: Log Continuously Threshold

A threshold of 0 will allow all readings to be recorded.
The threshold indicator will turn green if the threshold of the triggered reading is met (recording) and red if the

triggered reading is below the threshold (no recording).
The threshold value is saved in the registry configuration file when it is changed. Changes can only be made while not

recording.
An override from the command line options (-LCTH,x) can be made. The override will only take effect for the current

session and will not alter the saved configuration.

Pre-reading audio alert In cases where you want to be alerted that a reading will be taken, for example, when manually
pointing the meter, the Pre-reading audio alert (Fig. 7.28) can be enabled to play an audio file two seconds before the
record is logged. The Test button plays this file for test purposes. The audio file is named prereading.wav and is located
in the Data Directory (which can be identified from the main page View→Directories).

Figure 7.28: Log Continuously Pre-audio alert

Alarm for darkness When the darkness is over the threshold amount, an audio file can be enabled to play (Fig. 7.29) .
The Test button plays this file for test purposes. The audio file is named alarmsound.wav and is located in the the Data
Directory (which can be identified from the main page View→Directories).

Figure 7.29: Log Continuously Alarm for darkness
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Transfer The .dat file can be sent via FTP or SCP to a server by by making settings on the left side of the Transfer tab
(shown in Fig. 7.30)

Figure 7.30: Log Continuously Transfer tab

SCP transfers require that the scp command exists externally from UDM. For Linux and Mac, the scp command is
scp and can be proven to exist with the which scp command. In Windows, you may have to install a program called
pscp and rename it to scp.

Annotation settings While the “Log Continuous” mode is recording data, annotations can be made to the log file records
with hotkeys. The Annotation tab allows the definition of hotkeys and their associated annotation text that will appear
at the end of an annotated record.

Figure 7.31: Log Continuously Annotation tab

Persistent annotation The “Persistent” mode makes the annotated text persistently appear at the end of each logged
record after the first time the hotkey is pressed.

Without “Persistent” checked, annotation text is only appended to a record when the hotkey is pressed, and other
records have no annotation text.

Synchronized annotation The “Synchronized” mode postpones annotation requests until the next scheduled record so
that the annotated text is synchronized with scheduled triggered recordings.

Without “Synchronized” checked, the hotkey will immediately trigger a record log, and the associated annotation text
will be appended to that triggered record.
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GPS UDM will read the data produced from an externally connected USB or serial GPS receiver like the GlobalSat
BU-353 GPS. Also the Bluetooth GPS Dual XGPS160 has been test on a Mac.

Figure 7.32: Log Continuously GPS tab

The following GPS units have been tested with the latest UDM software:

GPS Connection Settings

GlobalSat BU-353 USB 4800 baud

GlobalSat BU-353 S4 (5Hz) USB 115200 baud

Dual XGPS160 Bluetooth See GPS owners manual

Enter the communications port name (see below) into the Port field, the baud rate into the baud field, then enable the
GPS. Once enabled, UDM continuously scans the GPS port for three NMEA words.

GPS on Windows 10 To get the Communications Port for a USB connected GPS to a Windows 10 computer:

• Click Start → Settings → Devices → Connected-devices

• The GPS should show up there as ”Prolific USB-to-Serial Comm Port (COMx)”. note which Comm port is listed,
one example is COM6 GlobalSat BU-353 S4 (5Hz)

• Make sure that no other programs are accessing the GPS.

• Start up UDM, make sure you meter is selected

• Select Log Continuous → GPS-tab

• Enter the Comm Port into the Port: field, in my case I just typed in COM6

• Enter the baud rate for the GPS into the Baud: field, in my case I just typed in 115200

GPS on Mac To get the Communications Port for a USB connected GPS to a Mac computer:

• Follow the instructions for driver installation on the CD provided with the GPS

• Connect the GPS

• Open a terminal window

• Type in: ls -altr /dev/* to look for the most recently created file that looks something like cu.usbserial

• The newly connected GPS is located at something like /dev/cu.usbserial

• Make sure that no other programs are accessing the GPS.

• In UDM → Log-continuous → GPS → Port:, type in that filename. An example would be: /dev/cu.usbserial

• Enter the baud rate for the GPS into the Baud: field, in my case I just typed in 115200
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GPS status Upon succesful parsing of the GPS data, UDM illuminates (with bright green) the associated indicators
(GPRMC, GPGGA, GPGSV). If too much time passes, the indicators fade to black.

The signal strength group shows the signal to noise ratio (SNR) for all visible satellites. The satellite number is displayed
below each signal strength meter.

The location, speed, time, and status information is displayed as it is received.
If the GPS is enabled before logging, then the logfile is forced to ”MOVING” platform mode, and five fields (latitude,

longitude, elevation, speed, number of satellites in view) are appended to each record.

GoTo A GoTo pointing device accessory can be controlled by UDM for the purpose of pointing the meter to various
parts of the sky and automatically gathering a reading at each position.

The following GoTo devices are currently supported:

• SynScan V4

• iOptron 8408

The connection of the GoTo device is made to the serial port. Note; some USB to RS232 serial adapters do not act
properly with UDM. Usually an FTDI addapter should work well.

Select the machine type, port, and baud rate. Ensure that the connected device is actually available on the port you
select. In Windows, you can use the Device manager, In Mac and Linux, you can type dmesg on the command line in a
terminal window to see the latest USB device attached.

A script file containing the positions is located in the “Data Directory” which is identified by:
View→Directories→Data Directory.

On a Mac, you can use Finder to go to “Applications”, then right click on “udm” or “udm.app” then select “Show
contents”. Then you can navigate to Contents→Resources to see the location of the *.goto file(s).

The format of the GoTo script file is a semicolon-separated file with an extension of “.goto”. Comment lines are preceded
by the pound symbol (#). The second line defines the field format (Zenith;Azimuth). The remaining lines define the
points to move to. An example is:

# Default

# Zenith;Azimuth

0;0

15;0

15;60

15;120

Control of the positioning is done from the trigger page. The “Goto accessory” and “Freshness” check boxes must be
set. Pressing the ”Record” button will start the pointing sequence.

7.5.1 Import.dat into spreadsheet

The .dat file generated by UDM can be imported into a Microsoft Excel spreadsheet for calculations and graphing purposes
as follows:

1. Start excel

2. File Open

3. Select ”All files”

4. Select your .dat file (previously recorded and saved).

5. Select ”delimited” (as opposed to the default ”fixed width”)

6. Import starting at line 33

7. Next

8. Unselect ”Tab”
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9. Select ”Semicolon”, you should see bars separating the data fields now.

10. Next

11. Define each field. European users will have to select ”Advanced”, then change the ”Decimal point” to ”.” and
”Thousands separator” to ”,”

12. field 1,2 = date YMD

Note: You can also use the “.dat to Moon .csv” tool shown in Fig. 7.11 to create a comma separated variable file for
importing into a spreadsheet like Excel.
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7.6 Calibration tab

The Calibration tab is used to show and set the calibration data for the selected SQM device.

Figure 7.33: Calibration tab (initial)

Press the “Get Calibration Info” button so that the updated calibration data is brought in from the SQM on to the
Actual values boxes as show below.

Figure 7.34: Calibration tab (populated)

Use the following steps to change the calibration values:

1. Enter the new calibration data on the left side entry box (Desired values column).

2. Press the associated “Set” button.

3. The value is sent to the SQM, and then confirmed in the right side box (Actual values column).

Note that temperatures set in to the SQM use their own resolution and may not be reflected as the same value entered.
For example. 24.7◦C might read back as 24.8 ◦C.
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The original factory calibration values were provided on a paper with the shipped unit. If you have lost this information,
please contact Unihedron to have the information emailed.

7.7 Report Interval tab

The Report Interval tab is used to show and set the report interval information for the selected SQM. Report interval
settings are used to control the SQM to send readings out at a regular rate (in seconds) and only if darker than a specified
threshold value. See section 8.7 on page 79 for more information about “Interval reporting”.

Figure 7.35: Report interval tab

Use the “R” button to temporarily set the value in to RAM for experimentation. The new value will be used instantly.
The RAM value is set to the EEPROM value on power-up.

Use the “E/R” button to set the value in to EEPROM and RAM. The new value will be used instantly and also after
power up.

Report interval is measured in seconds (i.e. 300 = 5 minutes).
Report threshold is measured in Magnitudes per square arcsecond (mpsas), a larger positive value is darker.

7.7.1 Continuous reports

The Continuous reports section enables special features related to reporting through an optionally installed I2C interface
except for the Ideal crossover function selection.

Reporting enabled: The readings are sent to the I2C adapter as they are computed.

Reporting compressed: High speed reporting is sent out in a compressed format.

Report un-averaged: Send only the unaveraged readings to the I2C device.

LED blink accessory: Enables the LED on the DL models to blink each time a reading is gathered.

Ideal crossover firmware: See Theory of operation section 3.1 for full details.

7.8 Firmware tab

In a case where new firmware is supplied by Unihedron to correct bugs or add features, use this tab to select and load
firmware in to the SQM-LU-DL.
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All available versions of firmware are shipped with the UDM software package in case you want to revert to an earlier
firmware version for testing purposes. New firmware versions are announced on the Unihedron forum.

Figure 7.36: Firmware tab

Follow these steps to load new firmware:

1. Press the “Select Firmware” button to choose the firmware file to load in to the SQM as shown in Figure 7.37:

Figure 7.37: Firmware selection

2. Select the desired firmware file then press “Open”.

3. The “Load firmware” button will be enabled and you can press it now to start loading the firmware in to the
SQM-LU-DL. The status bar will indicate successful completion when the firmware has been completely loaded.

7.9 Configuration tab

The “Configuration tab” shows the factory-set calibration values.
Calibration is performed at the Unihedron factory. A new calibration using a calibrated light source and darkroom can

be performed by following the instructions on the right side of the screen. The calibration report can be logged to a data
file and also printed out from this screen.

48 Unihedron SQM-LU-DL Operator’s Manual - 20190611



7.9 Configuration tab

Figure 7.38: Configuration tab

Warning confirmations as shown in Figure 7.39 and Figure 7.40 are shown when trying to calibrate the unit yourself:

Figure 7.39: Light calibration confirmation

Figure 7.40: Dark calibration confirmation

7.9.1 Sensor arrangement

For documentation purposes, the SQM-LU-DL can store information on the sensor arrangement (starting at firmware
feature 35 and above). The type of Lensholder, Lens, and Filter can be defined.

Figure 7.41: Sensor arrangement
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7.10 Data Logging tab

The “Data Logging” tab is available when an SQM-LU-DL unit is connected and selected.

Figure 7.42: Data logging tab

Trigger group Select one of the items in the trigger group to define when the SQM-LU-DL will record data while
connected to a battery instead of connected to the computer.

Threshold : mpsas Readings darker than the threshold value (mpsas) will be recorded. Readings brighter (lower value)
than the threshold value will be ignored. The SQM-LU-DL still has to turn on to determine the brightness value.

Battery Life estimator Use the “Battery life estimator” to determine the approximate battery life with the selected
trigger settings.

A custom mAH value may be entered directly into the “Capacity” field to instantly show a calculated duration approx-
imation.

Device Clock To set the RTC on the SQM-LU-DL, press the “Device Clock” button to call up the “Real Time Clock”
dialog. While the RTC dialog is shown, UDM continuously polls the SQM-LU-DL for an updated Unit clock value. The
UTC and local time are taken from the computer that UDM is running on.

Figure 7.43: Real Time Clock setting dialog

Pressing the “Set” button will copy the UTC time in to the SQM-LU-DL. Due to single second resolution, the clocks
may never match within 0 seconds difference. The SQM-LU-DL clock is as accurate as a common digital watch, it may
drift a few seconds per day.
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Storage The “Storage” section shows the contents of the SQM-LU-DL data-logging memory.
The position buttons shown below are used to move through the data-logger memory and view individual records:

Figure 7.44: Storage navigation

Table 7.2: Storage navigation button descriptions

Button Description

Move the current record pointer to the first record stored in the SQM-
LU-DL and display that record.

Move the current record pointer back 10 percent of the total records
and display that record. Does nothing if already displaying the first
record.

Move the current record pointer back one position and display that
record. Does nothing if already displaying the first record.

Move the current record pointer forward one position and display
that record. Does nothing if already displaying the last record.

Move the current record pointer forward 10 percent of the total
records and display that record. Does nothing if already displaying
the last record.

Move the current record pointer to the first record stored in the SQM-
LU-DL and display that record. Note that if the meter is still record-
ing values, the last position will be increasing, so continued presses
of this button may result in the display of new records.

Retrieve Press the “Retrieve” button to call up the “Retrieve” dialog shown in Figure 7.45.
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Figure 7.45: DL Retrieve dialog window

Header The “Header” button calls up the details that are stored on the computer when a data-logger data is retrieved
and written to disk. See page 31 for more information.

Retrieve All Press the “Retrieve All” button to collect all recorded data points from the SQM-LU-DL unit and store to
a file. Depending on the number of data-points, this action may take a long time.

When the retrieval is complete, the file location will be shown in the “recent file” section. You can access that stored
file by pressing the file-folder icon to the right of that filename, the file contents will be shown in the text box at the
bottom of the “DL Retrieve” dialog window.

Ret. All (bin) Faster than “Retrieve all”. Press the “Ret. All (bin)” button to collect all recorded data points from the
SQM-LU-DL unit and store to a file. This action is available in firmware feature version 47 and above.

When the retrieval is complete, the file location will be shown in the “recent file” section. You can access that stored
file by pressing the file-folder icon to the right of that filename, the file contents will be shown in the text box at the
bottom of the “DL Retrieve” dialog window.

Retrieve Range Press the “Retrieve Range” button to collect recorded data points in a range defined by the next two
fields (start-range to end-range) from the SQM-LU-DL unit and store to a file. Depending on the number of data-points,
this action may take a long time.

The first record in the unit starts at 1.

The ending record is defined in the [xxxx max] text displayed to the right of the end range. You can enter -1 into the
end-range field to indicate the last record. An ending range beyond the max will pull in data records that have not yet
been written to (odd values will be displayed).
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When the retrieval is complete, the file location will be shown in the “recent file” section. You can access that stored
file by pressing the file-folder icon to the right of that filename, the file contents will be shown in the text box at the
bottom of the “DL Retrieve” dialog window.

Cancel Retrieve Press the “Cancel Retrieve” button to cancel a “Retrieve All” or ”Retrieve range” action.

Log one Press the “Log one” button to record a single record in the data log memory of the SQM-LU-DL. The data
log window will be instantly updated with the result of your action and point to the latest record.

Erase All The “Erase All” button calls up the “Erase” dialog window shown below

Figure 7.46: DL Erase dialog window

• The total size of erasable memory and range of erase time is shown.

• Pressing “Close” before the erasing starts will close this dialog window.

• Pressing the “Erase all” button on this dialog window starts the unstoppable erase procedure. All data log records
will be removed from the SQM-LU-DL data log memory.

• While the erasing is taking place, the dialog window shows the current status of time taken to complete the erasure.

7.10.1 Vector datalogger

The SQM-LU-DL can be setup for an all-sky survey of brightness data points. Refer to Figure 7.47 for key points.
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Figure 7.47: Datalogging page for vector model

7.10.2 Contour plot

Follow these steps to see a contour plot of the retrieved data:

• Select the “Tools - DL Retrieve” menu item or the “Data Logging” tab then the “Retrieve All” button.

• Select the “Plot” tab.

• Click the “Show data” button, and select the previously retrieved log file.

• The contour plot will appear after all the points have been read in and processed which could take a long time
depending on the number of recorded points.

An example of the contour plot is shown in Figure 7.48.
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Figure 7.48: Contour plot of 336 readings

7.10.3 Minimum .dat requirements

The Contour plot reads records from a .dat file created by retrieving data from the SQM-LU-DL. You can use other
methods to generate the Altitude and Azimuth field and make up a .dat file yourself. The minimum requirements for the
.dat file to be read by the contour plotting function are:

• One comment line describing the field of UTC Date & Time, Altitude, Azimuth.

• One line defining the ending of the header.

• Following lines of data

Here is an example:
# UTC Date & Time, MSAS, Altitude, Azimuth

# END OF HEADER

2018-05-15T06:05:24.057;21.85;0;0

2018-05-15T06:05:34.040;21.86;20;0

7.11 Simulation tab

The “Simulation” tab is enabled from the View menu.
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The “Simulation” tab allows the simulation of raw light sensor values for experimentation purposes. The “Start” button
initiates feeding the range of values to the internal formulas of the SQM-LU-DL and results are displayed on this tab.
Raw temperature conversions are detail in Eq: 8.1 and 8.2. The simulation will stop once all the steps are complete or
when the “Stop” button is pressed.

Figure 7.49: Fig:Simulation tab

When using the Simulation mode of the SQM-LU-DL, make sure that nothing else interrupts the sequence of readings
such as external programs reading from the SQM-LU-DL, or settings of Interval reporting inside the SQM-LU-DL.

7.11.1 Simulation from file

The “From file” button sends csv data from simin.csv (in the log file directory) to the SQM-LU-DL in simulation mode
and puts the output into simout.csv. The format of the csv is shown in Table 7.3:

Table 7.3: simin.csv field description

Position Example value Description

1 3000 Period in counts.

2 30 Frequency in Hz.

3 20.3 Temperature in ◦C.

Listing 7.2: simin.csv example

0,568380,24.8

72970,6,13.2

The resultant output records will be shown on the screen and saved in simout.csv (in the log file directory) in the
form of simulated result shown in section 8.8 as in the example shown in Listing 7.3:

Listing 7.3: simout.csv example

# Simulation from file.

# UDM version: 1.0.0.43

# Unit information cx: i,00000004,00000003,00000032,00000704

# Calibration cx: c,00000019.80m,0000107.511s, 028.3C,00000008.71m, 029.3C

S,0000000000c,0000568380f,0000000232t,r, 00.00m,0000568380Hz,0000000000c,0000000.000s, 024.8C

S,0000072970c,0000000006f,0000000196t,r, 17.79m,0000000006Hz,0000072970c,0000000.158s, 013.2C
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7.12 Accessory options

Some meters can be equipped/retro-fitted with optional accessories if they include firmware feature version ≥40.
See section ?? for details on the accessory commands.
The accessories tab (shown in 7.50) is available when selecting a device that has the appropriate firmware:

Figure 7.50: Accessories tab

7.12.1 Humidity accessory

The humidity sensor accessory option is currently not available for the SQM-LU-DL.

7.12.2 Display accessory

The display accessory option is currently not available for the SQM-LU-DL.

7.12.3 LED accessory

The SQM-LU-DL has the LED accessory hardware built in to the back panel.
The LED indicator accessory is mainly used for troubleshooting to identify either when readings are created or requested.

The LED draws current and it may not be desireable to enable it when operating from the battery pack. The LED blinks
for 1/60th of a second.

The LED can blink either when the SQM-LU-DL creates a reading, of when a reading is requested (using the rx
command).

7.12.4 Relay accessory

The Relay accessory is mainly used for dew heater control. A 3.3V activated solid state relay can be connected directly
to pin 23 of the microcontroller (25mA drive maximum).

When in Manual mode, the relay can be turned on or off.
When in Automatic mode, the relay is turned on when the mpsas reading is above the threshold and off when the

mpsas reading is below the threshold.
Pressing the On/Off buttons while the realy is in automatic mode will switch it to manual mode.
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7.13 Command line parameters

UDM can be started from the command line. Other stored parameters (like timezone) will be recalled automatically.
Here is the summary of options:

Table 7.4: Log continuous command line parameters

Parameter Description

-LCMS,x Every x seconds

-LCMM,x Every x minutes

-LCM,1 Every 1 minute on the minute

-LCM,5 Every 5 minutes on the 1/12th hour

-LCM,10 Every 10 minutes on the 1/6th hour

-LCM,15 Every 15 minutes on the 1/4 hour

-LCM,30 Every 30 minutes on the 1/2 hour

-LCM,60 Every hour on the hour

-LCR Start recording right away

-LCTH,x Threshold setting. Readings equal to or greater than x (in mpsas)
get recorded. If x=0 then all readings are get recorded.

-LCMIN Minimize Application after Log continuous window starts up

Table 7.5: Select device command line parameters

Parameter Description

-SEI,x Select Ethernet device where x = IP address

-SEM,x Select Ethernet device where x = MAC address

-SUC,x Select USB device
where x = communication portname i.e. /tty/USB0

-SUI,x Select USB device where x = ID number ex FTD12345

Table 7.6: Select device command line parameters

Parameter Description

-N Do not search for devices at startup. This cuts down startup time,
the user must press the Find button to find devices.

-P Display plotter window.
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The SQM-LU-DL accepts a sequence of characters as a command, then executes those commands and usually provides a
response of a sequence of characters. The following details are useful when programming your own interface to send data
to and receive data from the SQM-LU-DL.

8.1 Commands

Commands consist of a string of characters. The first character is the command type. The following is a list of the
“Standard” commands:

Table 8.1: Summary of standard commands

Command Description

rx Reading request.

cx Calibration information request.

ix Unit information request (note lower case “i”).

zcalAx Arm Light Calibration command.

zcalBx Arm Dark Calibration command.

zcalDx Disarm Calibration command.

zcal5 Manually Set Light Calibration Offset.

zcal6 Manually Set Light Calibration Temperature.

zcal7 Manually Set Dark Calibration Time Period.

zcal8 Manually Set Dark Calibration Temperature.

0x19 Reset micro-controller. Hexadecimal value 19. See the “Firmware Upgrade” chapter
on page 86 for more details.

: Intel Hex firmware upgrade initiation. See the “Firmware Upgrade” chapter on
page 86 for more details.

P...x Set period (in seconds) for interval reporting to EEPROM and RAM for booting
and immediate use. Firmware feature=13.

p...x Set period (in seconds) for interval reporting to RAM for immediate use. Firmware
feature=13.

T...x Set threshold (in mag
arcsec2 ) for interval reporting only to EEPROM and RAM for

booting and immediate use. Firmware feature≥13.

t...x Set threshold (in mag
arcsec2 ) for interval reporting only to RAM for immediate use.

Firmware feature≥13.

Ix Request interval settings (note upper case “I”). Firmware feature≥13.

sx Request reading of internal variables.

S...x Simulate internal calculations.
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The following is a list of the ”Data logger” commands:

Table 8.2: Summary of datalogger commands

Command Description

L0x Report on FLASH chip Manufacturer ID, and Device ID.

L1x Report on logging pointer.

LZx Report on logging capacity.

L2x Erase entire FLASH chip contents.

L3x Log one record.

L4...x Return one record.

L5x Get battery voltage.

L6x Get status register1.

L7x Report on bytes per FLASH, bytes per record.

LM.x Set Logging trigger mode, next digit defines mode.

Lmx Get Logging trigger mode.

LIx Logging Interval settings requested.

LPS...x Logging Interval period set in seconds.

LPM...x Logging Interval period set in minutes.

LT...x Logging Threshold for interval reports set.

Lcx Get real time clock data.

LC...x Set real time clock data.

Lsx Put unit to sleep.

Lax Get alarm data.
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8.2 Response details

8.2.1 Reading request

The “Reading” request “rx” or “Rx” commands the SQM-LU-DL to provide the current darkness value as well as all
variables used to generate that result.

Readings produced by this request are averaged internally by using the last 8 readings and shifting those values through
an 8 cell buffer then summing and dividing by 8. Use the “ux” command to get the un-averaged and most recent value.
Averaging is only performed on period-mode readings (when the light sensor frequency is below 128Hz). Frequency mode
readings (above 128Hz) are automatically averaged because the reading is taken from a one second sampling of pulses.

The format of the response is shown in table 8.3:

Table 8.3: Reading request response

Column Example value Description

0 r Indicates that a reading is being returned.

2-8 06.70m Reading in mag
arcsec2 .

Leading space for positive value.
Leading negative sign (-) for negative value.
A reading of 0.00m means that the light at the sensor has reached
the upper brightness limit of the unit.

10-21 0000022921Hz Frequency of sensor in Hz.

23-33 0000000020c Period of sensor in counts, counts occur at a rate of 460.8 kHz
(14.7456MHz/32).

35-46 0000000.000s Period of sensor in seconds with millisecond resolution.

48-54 039.4C Temperature measured at light sensor in degrees C.
Leading space for positive value.
Leading negative sign (-) for negative value.

55-56 Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
r, 06.70m,0000022921Hz,0000000020c,0000000.000s, 039.4C

0123456789 123456789 123456789 123456789 123456789 123456

Future versions of this reading string will only modify reported values beyond position 54. Characters 0 to 54 may be
considered stable.

A special case “Rx” command returns the serial number in the same format as the interval report does. See page 79
“Setting Interval reporting parameters” for report details.

8.2.2 Unaveraged reading request

The “unaveraged reading” request “ux” commands the meter to provide the current darkness value as well as all variables
used to generate that result. This readings is not averaged out like the “rx” command.

The format of the response is shown in table 8.4:

Table 8.4: Unaveraged reading request response

Column Example value Description

0 u Indicates that a reading is being returned.

Table continued on next page ...
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Table 8.4 – continued from previous page

Column Example value Description

2-8 06.70m Reading in mag
arcsec2 .

Leading space for positive value.
Leading negative sign (-) for negative value.
A reading of 0.00m means that the light at the sensor has reached
the upper brightness limit of the unit.

10-21 0000022921Hz Frequency of sensor in Hz.

23-33 0000000020c Period of sensor in counts, counts occur at a rate of 460.8 kHz
(14.7456MHz/32).

35-46 0000000.000s Period of sensor in seconds with millisecond resolution.

48-54 039.4C Temperature measured at light sensor in degrees C.
Leading space for positive value.
Leading negative sign (-) for negative value.

55-56 Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
u, 06.70m,0000022921Hz,0000000020c,0000000.000s, 039.4C

0123456789 123456789 123456789 123456789 123456789 123456

Future versions of this reading string will only modify reported values beyond position 54. Characters 0 to 54 may be
considered stable.

8.2.3 Linear reading request

The “linear reading” request “rfx” commands the meter to provide the current brightness value proportional to the light
flux or frequency output from the light sensor. This value is compensated for only by the dark current frequency.
fout = flight − fdark

To allow for long period measurements, the output integer value is scaled up by a factor of 45,000.
nout = fout × 45000

The format of the response is shown in table 8.5:

Table 8.5: Linear reading request response

Column Example value Description

0-1 f, Indicates that a frequency reading is being returned.

2-11 0001287103 Frequency reading.

A reading of 0000045000 would indicate a sensor frequency of 1Hz,
but the meter limits to 25kHz for later scaling of snow factor, so the
maximum value would be 1125045000 (25kHz × 45000).

A reading of 0000000000 would indicate total darkness, but the meter
limits time readings to 85 seconds maximum, so the darkest value

would be 0000000529 (
1

85s
× 45000).

55-56 Carriage return (0x0d), Line feed (0x0a).
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An example of the response is:
f,0001287103

0123456789 123

8.2.4 Unit information

Unit information command “ix” provides details about the software in the micro-controller.
The format of the response is:

Table 8.6: Unit information request response

Column Example value Description

0 i Indicates that the unit information response is being returned.

2-9 00000002 Protocol number (8 digits). This will always be the first 8 char-
acters (after the “i,” response). This value indicates the revision
number of the data protocol to/from the SQM-LU-DL. The protocol
version is independent of the feature version.

11-18 00000003 Model number (8 digits). The model value identifies the specific
hardware model that the firmware is tailored for.

20-27 00000001 Feature number (8 digits). The feature value identifies software
features. This number is independent of the data protocol.

29-36 00000413 Serial number (8 digits). Each unit has its own unique serial num-
ber.

37-38 Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
i,00000002,00000003,00000001,00000413

0123456789 123456789 123456789 12345678

8.3 Calibration commands

8.3.1 Calibration information request

The calibration information request “cx” returns all data about the specific light sensor in the unit required to calculate
a reading.

The format of the response is shown in table 8.7:

Table 8.7: Calibration information request response

Column Example value Description

0 c Indicates that the calibration information is being returned.

2-13 00000017.60m Light calibration offset in mag
arcsec2 .

15-26 0000000.000s Dark calibration time period in seconds with millisecond resolution.

28-34 039.4C Temperature in degrees C measured during light calibration.
Leading space for positive value.
Leading negative sign (-) for negative value.

Table continued on next page ...
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Table 8.7 – continued from previous page

Column Example value Description

36-47 00000008.71m Offset of light sensor in mag
arcsec2 based on manufacturing reference.

The factory calibration light source is equivalent to 8.71 mag
arcsec2 , and

when the “Light calibration” button is pressed in UDM, the meter
creates the light calibration offset value (17.60 in this case) so that
the meter reads 8.71 also.

49-55 039.4C Temperature in degrees C measured during dark calibration.
Leading space for positive value.
Leading negative sign (-) for negative value.

56-57 Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
c,00000017.60m,0000000.000s, 039.4C,00000008.71m, 039.4C

0123456789 123456789 123456789 123456789 123456789 1234567

8.3.2 Light calibration command

Calibration of the SQM-LU-DL is done at the factory in a controlled light and temperature environment.
Executing the Light calibration command “zcalAx” arms the light calibration mode.
A calibrated light source of approximately 13.5fc is supplied to the sensor.
The format of the response is shown in table 8.8:

Table 8.8: Light calibration response

Column Example value Description

0 z Indicates that a “Calibration” response is being returned.

1 A Indicates Light Calibration mode.

2 a Indicates that the calibration is armed.

3 L L = Locked; Wait for unlock before calibrating after Arm command,
firmware upgrades are disabled.
U = Unlocked; Calibrate immediately after Arm command, Enable
firmware upgrade.

4-5 Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
zAaL

012345

8.3.3 Dark calibration command

Dark Calibration is done at the factory along with Light calibration and calibration temperature recording.
Executing the dark calibration command “zcalBx” arms the dark calibration mode.
Dark calibration is performed in a completely dark environment. Check a reading to ensure that the period is correct

after entering the dark environment, it could take a few minutes to collect an accurate dark period. A dark period of only
a few seconds is too small.

The format of the response is shown in table 8.9:
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Table 8.9: Dark calibration response

Column Example value Description

0 z Calibration response is being returned.

1 B Dark Calibration.

2 a Armed.

3 L L = Locked; Wait for unlock before calibrating after Arm command,
firmware upgrades are disabled.
U = Unlocked; Calibrate immediately after Arm command, Enable
firmware upgrade.

4-5 Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
zBaL

012345

8.3.4 Disarm calibration command

The Disarm calibration command “zcalDx” disarms calibration modes from being triggered by the unlock mode.
The format of the response is shown in table 8.10:

Table 8.10: Disarm calibration response

Column Example value Description

0 z Calibration response is being returned.

1 x Indicates “All” calibration modes.

2 d Disarmed.

3 L L = Locked; Wait for unlock before calibrating after Arm command,
firmware upgrades are disabled.
U = Unlocked; Calibrate immediately after Arm command, Enable
firmware upgrade.

4-5 Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
zxdL

012345

8.3.5 Manually set light calibration offset

Calibration is done at the factory, however, in the case where calibration values must be restored or set to something else,
this command allows a new calibration value to be placed into the meter.

Executing the command “zcal5########.##x” manually sets the light calibration offset to the value specified in
“########.##”. The units are magnitudes

arcsecond2 .
The format of the response is shown in table: 8.11:
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Table 8.11: Response for manual setting of light calibration offset

Column Example value Description

0 z Calibration response is being returned.

2 5 Manual Set Light Calibration Offset

4-15 00000017.60m Value that was set into EEPROM

16-17 Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
z,5,00000017.60m

0123456789 1234567

8.3.6 Manually set light calibration temperature

Calibration is done at the factory, however, in the case where calibration values must be restored or set to something else,
this command allows a new calibration value to be placed into the meter.

The “Light calibration temperature” is the temperature of the meter when the meter was calibrated for its “Light
calibration offset”.

Executing the command “zcal6########.##x” manually sets the light calibration temperature to the value specified
in “########.##”. The units are oC.

Note: The meter records the temperature in a raw value with different resolution, so the reply back may not be exactly
the same as the value sent.

The format of the response is shown in table: 8.12:

Table 8.12: Response for manually setting of light calibration temperature

Column Example value Description

0 z Calibration response is being returned.

2 6 Manual Set Light Calibration Offset

4-9 019.0C Value that was set into EEPROM

10-11 Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
z,6,019.0C

0123456789 1

8.3.7 Manually set dark calibration time period

Calibration is done at the factory, however, in the case where calibration values must be restored or set to something else,
this command allows a new calibration value to be placed into the meter.

The “Dark calibration time period” is the amount of time that has elapsed for the light sensor to make one cycle while
in complete darkness. The meter sets a time limit of 300 seconds on this value.

Executing the command “zcal7#######.###x” manually sets the light calibration offset to the value specified in
“#######.###”. The units are in seconds.

The format of the response is shown in table: 8.13:
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Table 8.13: Response of manually setting dark calibration time period

Column Example value Description

0 z Calibration response is being returned.

2 7 Manual Set Dark Calibration time period.

4-15 0000300.000s Value that was set into EEPROM

16-17 Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
z,7,00000300.00s

0123456789 1234567

8.3.8 Manually set dark calibration temperature

Calibration is done at the factory, however, in the case where calibration values must be restored or set to something else,
this command allows a new calibration value to be placed into the meter.

The “Dark calibration temperature” is the temperature of the meter when the meter was calibrated for its “Dark
calibration time period”.

Executing the command “zcal8########.##x” manually sets the light calibration offset to the value specified in
“########.##”. The units are oC.

Note: The meter records the temperature in a raw value with different resolution, so the reply back may not be exactly
the same as the value sent.

The format of the response is shown in table: 8.14:

Table 8.14: Response for manually setting of dark calibration temperature

Column Example value Description

0 z Calibration response is being returned.

2 8 Manual Set Dark Calibration temperature.

4-9 019.0C Value that was set into EEPROM

10-11 Carriage return (0x0d), Line feed (0x0a).

An example of the response is:
z,8,019.0C

0123456789 1

8.4 Snow LED accessory

An LED used for determining snow cover on the meter can be attached to an internal pin of the SQM-LU-DL . This LED
shines green light out of the meter and the light sensor will see a reflection if snow is covering the meter (housing cap).
The light meter reading will be unchanged with no snow present, and about 1.6 mag

arcsec2 brighter with snow cover present.

Table 8.15: LED accessory command summary

Command Description

A50x Turn off the Snow LED accessory.

Table continued on next page ...
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Table 8.15 – continued from previous page

Command Description

A51x Turn on the Snow LED accessory.

A5ex Enable Snow LED logging (while on battery power).

A5dx Disable Snow LED logging (while on battery power).

A5x LED accessory status.

Table 8.16: LED accessory response summary

Position Example value Description

0-2 A5, Confirmation Snow LED accessory command.

3 n Where n = 0 indicates the Snow LED is Off.
1 indicates the Snow LED is On.

4 m Where m 0 indicates the Snow LED is dsiabled .
1 indicates the Snow LED is enabled.

Carriage return (0x0d), Line feed (0x0a).

An example response to “A5x” is:
A5,0
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8.5 Datalogger commands

The SQM-LU-DL contains datalogging capabilities.
All of the datalogging commands begin with “L”.

8.5.1 FLASH ID report

The FLASH memory chip stores all the data logging records. It does not contain any calibration information.
The ID report is useful for determining the exact model of FLASH device inside the SQM-LU-DL for record capacity

calculations.
To get a report on FLASH chip Manufacturer ID, and Device ID, use “L0x”. The response is shown in table 8.17:

Table 8.17: Response of requesting the FLASH chip ID

Column Example value Description

0-2 L0, Confirmation of command.

3-5 000 Manufacturer ID.

6-8 000 Device ID.

9-10 Carriage return (0x0d), Line feed (0x0a).

An example response is:
L0,000,000

0123456789 1

8.5.2 Logging pointer report

To get a report on current logging pointer position, use the “L1x” command.
This pointer is the record address of where the next record will be stored.
Note: Before feature 27, the pointer position was only 6 characters long, from feature 27 onwards, the pointer position

is 10 characters long. The response is shown in table 8.18:

Table 8.18: Response of requesting the data logging pointer

Column Example value Description

0-2 L1, Confirmation of command

3-12 0000000000 Pointer position
0 means that no records have been stored.
1 means that one record has been stored.
When the FLASH memory is full, this number will always point to
the last record and will be equal to the storage capacity (see LZx).
I.e. 1048575 for the larger memory

13-14 Carriage return (0x0d), Line feed (0x0a).

An example response is:

L1,0000000000

0123456789 1234
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8.5.3 Logging capacity report

To get the totql logging capacity of the FLASH memory chip installed in the meter, use the “LZx” command. This
command is available on feature ≥27. The response is shown in table 8.19:

Table 8.19: Response of requesting the data logging capacity

Column Example value Description

0-2 LZ, Confirmation of command

3-8 0000032768 Capacity of records that can be stored in the FLASH memory.
Ex. 32768, 65536, 524288, or 1048576.

9-10 Carriage return (0x0d), Line feed (0x0a).

An example response is:
LZ,0001048567

0123456789 1234

8.5.4 Erase entire FLASH memory

Erasing the entire FLASH memory deletes all previously recorded datalogged records. To erase the entire FLASH memory,
use the “L2x” command. There is no response.

8.5.5 Log one record

To force the unit to record one complete record into the FLASH memory, use the “L3x” command.
The record will not be logged if the threshold is set too high. To ensure that a record will be logged, set the threshold

to 0.
Note: Before feature 27, the pointer position was only 6 characters long, from feature 27 onwards, the pointer position

is 10
The response includes the logging pointer as shown in table 8.20:

Table 8.20: Response of requesting to log one record

Column Example value Description

0-2 L3, Confirmation of command

3-12 0000000000 Pointer position of next record

13-14 Carriage return (0x0d), Line feed (0x0a).

An example response is:
L3,0000000000

0123456789 1235

8.5.6 Return one logged record

To get one entire record, use the ‘L4...x” command. The request and response are as shown in table 8.21 and 8.22:
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Table 8.21: Request to return one logged record

Column Example value Description

0-1 L4 Command.

2-11 0000000000 Pointer position of record to return.
Value starts at 0 for record 1.
Unwritten (erased) records will respond as follows:
L4,55-55-55 5 55:55:55,00.00,-873.4C,255

12 x End of request.

13-14 Carriage return (0x0d), Line feed (0x0a).

Table 8.22: Response to return one logged record

Column Example value Description

3char L4, Confirmation of command.

20char 11-01-06 5

11:51:00,

Date, Day of week (1=Sunday), and time of recording

7-8char 10.44, Reading with sign.
* Uncalibrated meter may respond with leading negative sign (ex.
-11.49) which extends the length of the string.

8char 023.8C, Temperature in degrees C. Leading space replaced with negative sign
for negative temperature.

4char 234, Battery voltage ADC value.

1char 1 0 = First logged record from initial connection to battery.
1 = Subsequent logged reading triggered by time interval.
Available on firmware feature 49 and above.

2char ,1 Available on models with snow LED.
0 = No snow data recorded.
1 = Snow data recorded.
Available on firmware feature 66 and above.

number ,1234567890 Available on models with snow LED.
Standard linear luminance value taken with the snow LED off. The
value is representative of the brightness (larger number = brighter).
The linear value is a compensated value of 150 times the period counts
or 45000 times the frequency, with a switchover point at determined
by the crossover selection mode on the report interval page.

7-8char ,9.72 Available on models with snow LED.
Snow reading in mpsas which was taken when the snow LED was on.

number ,1234567890 Available on models with snow LED.
Snow linear luminance value. The linear value is computed similarly
to the standard linear value described above.

last two Carriage return (0x0d), Line feed (0x0a).

An example response is:
L4,11-01-06 5 11:51:00,10.44, 023.8C,234,1

0123456789 123456789 123456789 123456789 123
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8.5.7 Retrieve all Binary

To retrieve all records from the SQM-LU-DL faster than the “Return One logged record method”, you can use this faster
binary method.

Thr first command sent “L8x” returns the packet length, and number of packets to be sent. The response to this first
command is below:

Table 8.23: Response to Binary Retrieve command

Column Example value Description

0-2 L8, Confirmation of command.

3-13 1234567890, Packet length.

14-24 1234567890, Number of packets.

last two Carriage return (0x0d), Line feed (0x0a).

If there are any records to be sent, the first record will automatically be sent after the first command is sent.
Subsequent records must be prompted. This action is a software flow control method. The subsequent record requests

are made with the “x” command.
Each record contains binary values (not ASCII). Each record is defined below:

Table 8.24: Binary Retrieve record content

Column Example value Description

0 x Record type. Where bit:
0: 0 = written record, 1 = erased or unwritten record.
4: 0 = initial startup record, 1 = subsequent record taken after wak-
ing up from sleep. This bit is only valid for firmware feature ≥ 49.

1 x Seconds.

2 x Minutes.

3 x Hours.

4 x Day.

5 x Date.

6 x Month.

7 x Year.

8-11 xxxx Reading, raw 32 bit binary value for magnitudes. The decimal read-
ing value is determined as: ReadingMPSAS = xxxx

6553600.0 .

12-13 xx Temperature, raw 16 bit value. The decimal temperature value is

determined as: Temperature =
xx×33000.0

1024.0 −5000.0

100.0

14 x Battery voltage, raw 8 bit value where the decimal voltage is deter-

mined by: V oltage = (2.048 + (3.3∗x)
256.0 ).
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8.5.8 Get internal voltage

When operating from the external battery to USB connector, the unit is normally supplied 5V. As the external battery
voltage drops below 5V (plus the voltage regulator overhead of about 0.1V), the internally supplied unit voltage will drop
below 5V. The unit will continue to work while the internal voltage is above 3.3V. This internal voltage can be reported.

To get the internal voltage value, use the “L5x” command. The response is shown in table 8.25:

Table 8.25: Response of requesting internal voltage

Column Example value Description

0-2 L5, Confirmation of command.

3-5 238 Internal voltage ADC value.

Internal Voltage = 2.048 + (3.3∗$ADCV alue)
256.0

6-7 Carriage return (0x0d), Line feed (0x0a).

An example response is:
L5,238

01234567

8.5.9 Get EEPROM status register 1

In cases where the erasure of EEPROM memory takes a long time, it is necessary to read the status register busy bit (bit
0) using the “L6x” command. The response is shown in table 8.26:

Table 8.26: Response of requesting EEPROM Status regoster 1

Column Example value Description

0-2 L6, Confirmation of command.

3-5 000 Integer (value 0-255) represeting the status bits as follows:
bit 0 : 1 = Busy, 0 = Ready
bit 1-7 : Not useful outside the meter. Defined in the data sheet for
the Winbond W25Q128FV EEPROM.

last two Carriage return (0x0d), Line feed (0x0a).

8.5.10 Set and read logging trigger mode

The SQM-LU-DL has the following possible modes (see table 8.27) of logging data while the external battery is being
used for power:

Table 8.27: Request to set the logging trigger mode

Mode Description

LM0x No automatic logging

LM1x Logging granularity in seconds and not powering down.

LM2x Logging granularity in minutes and powering down between recordings.

LM3x Logging every 5 minutes on the 1/12th hour, and powering down between recordings.

Table continued on next page ...
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Table 8.27 – continued from previous page

Mode Description

LM4x Logging every 10 minutes on the 1/6th hour, and powering down between recordings.

LM5x Logging every 15 minutes on the 1/4 hour, and powering down between recordings.

LM6x Logging every 30 minutes on the 1/2 hour, and powering down between recordings.

LM7x Logging every hour on the hour, and powering down between recordings.

The response of setting the mode is simply an acknowledgement of the trigger mode. Also, reading the mode can be
done with “Lmx”, both will produce the response shown in table 8.28:

Table 8.28: Response of setting or getting the log trigger mode

Column Example value Description

0-2 LM, Confirmation of command.

3 0 0 = Off
1 = Seconds
2 = Minutes
3 = Every 5 minutes on the 1/12th hour
4 = Every 10 minutes on the 1/6th hour
5 = Every 15 minutes on the 1/4 hour
6 = Every 30 minutes on the 1/2 hour
7 = Every hour on the hour

4-5 Carriage return (0x0d), Line feed (0x0a).

An example response is:
LM,0

012345

8.5.11 Logging Interval setting response

Either making the request “LIx” or any request to set the logging interval report setting produces the response shown in
table 8.29:

Table 8.29: Response of viewing or setting logging interval reporting parameters

Column Example value Description

0-1 LI Logging interval settings from EEPROM and RAM are being re-
turned.

3-13 0000000360s Logging interval period in seconds that was set into EEPROM

15-25 0000000005m Logging interval period in minutes that was set into EEPROM

27-37 0000000121s Current interval period in seconds from RAM

39-49 0000000004m Current interval period in minutes from RAM

51-62 00000017.60m Threshold value that was set into RAM

63-64 Carriage return (0x0d), Line feed (0x0a).
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8.5 Datalogger commands

An example response is:
LI,0000000360s,0000000005m,0000000121s,0000000004m,00000017.60m

0123456789 123456789 123456789 123456789 123456789 123456789 1234

8.5.12 Logging interval reporting period setting

Executing the command “LPS##########x” sets the period (in seconds) of the timed interval reports to the EEPROM
and RAM for booting and immediate use. For example, the command “LPS0000000360x” sets the reporting time to once
every 360 seconds.

Executing the command “LPM##########x” sets the period (in minutes) of the timed interval reports to the EEPROM
and RAM for booting and immediate use. For example, the command “LPS0000000005x” sets the reporting time to once
every 5 minutes.

Logging threshold setting for interval reporting Executing the command “LT########.##x” sets the threshold of the
timed interval reports to EEPROM and RAM for boot and immediate use.

The units are magnitudes
arcsecond2 . For example, LT00000016.00x limits reporting to values only over 16.00 magnitudes

arcsecond2 .

8.5.13 Set and read logging Real Time Clock

The SQM-LU-DL model contains a Real Time Clock (RTC) powered by a Supercap (large storage capacitor).

The RTC is set with the “LCx” command as shown in table 8.30:

Table 8.30: Setting the RTC

Column Example value Description

0-1 LC Confirmation of command.

2-21 11-01-06 5

11:51:00x

Date, Day of week (1=Sunday), and time.

22-23 Carriage return (0x0d), Line feed (0x0a).

The RTC is read with the “Lcx” command. The response of both setting and getting the RTC value is shown in table
8.31:

Table 8.31: Response of getting the RTC values

Column Example value Description

0-2 LC, Confirmation of setting command.

0-2 Lc, Confirmation of getting command.

3-21 11-01-06 5

11:51:00

Date, Day of week (1=Sunday), and time.

22-23 Carriage return (0x0d), Line feed (0x0a).

An example response is:

Lc,11-01-06 5 11:51:00

0123456789 123456789 123

Unihedron SQM-LU-DL Operator’s Manual - 20190611 75
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8.5.14 Get Real Time Clock version

Original DL model units used the DS1305 Real Time Clock (RTC). Newer units (starting in 2016) used the more accurate
DS3234 RTC. The results of getting the RTC version with the “Lvx” command is shown in table 8.32:

Table 8.32: Response of getting the RTC version

Column Example value Description

0-2 Lv, Confirmation of command.

3 0 0=Original RTC DS1304 or unknown RTC
1=DS3234 RTC

4-5 Carriage return (0x0d), Line feed (0x0a).

An example response is:
Lv,0

012345

8.5.15 Put datalogging unit to sleep

For test purposes, the SQM-LU-DL can be put to sleep with the “Lsx” command so that the quiescent battery current
can be measured. The unit must be awakened by re-applying power (cold-start).

8.5.16 Gather alarm 0 data from RTC

For tests purposes, the SQM-LU-DL RTC “Alarm 0” data can be retrieved with the “Lax” command. The response is
shown in table 8.33:

Table 8.33: Response of getting the RTC “Alarm 0” value

Column Example value Description

0-1 La, Confirmation of command.

3-6 000, Address 07H, Seconds
See “DS1305N"+ RTC chip information for details.

7-10 128, Address 08H, minutes.

11-14 128, Address 09H, hours.

15-18 128, Address 0AH, day.

19-21 001, Address 0FH, Control register.

22-23 Carriage return (0x0d), Line feed (0x0a).

An example response is:
La,000,128,128,128,001

0123456789 123456789 123
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8.6 Continuous reporting commands

8.6 Continuous reporting commands

The Continuous reporting features are somewhat experimental. A description of each feature follows:

Table 8.34: Summary of standard commands

Option Description

Reporting enabled Send a reading result every time it is available from internal computations. In
bright settings, a reading will be made available once per second, around 14mpsas,
a reading will be available depending on the sensor response which is between 60+
times per second and 60 seconds in very dark settings.

Ideal crossover firmware Changes the crossover of reporting from original (around 15mpsas to 12.32mpsas
which results in better resolution across the entire range of possible readings.

Reporting compressed Send the above enabled reading out in a compressed format without extra text.

Report un-averaged Sends the above reading out from the un-averaged accumulator. Normally the
averaged reading is sent.

Table 8.35: Continuous reporting command summary

Command Description

Yx Get status of the continuous reporting features.

YRx Enable continuous reporting.

Yrx Disable continuous reporting.

YCx Enable new crossover firmware code.

Ycx Disable new crossover firmware code.

YPx Enable continuous reporting compression.

Ypx Disable continuous reporting compression.

YUx Enable un-averaged continuous reporting.

Yux Disable un-averaged continuous reporting.

Table 8.36: Response of all continuous reporting requests

Column Example value Description

0 Y Confirmation of command.

1 r R = Continuous reporting enabled.
r = Continuous reporting disabled.

2 C C = Ideal crossover firmware code enabled.
c = Ideal crossover firmware code disabled.

3 p P = Continuous reporting compression enabled.
p = Continuous reporting compression disabled.

Table continued on next page ...
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Table 8.36 – continued from previous page

Column Example value Description

4 u U = Continuous reporting un-averaged readings enabled.
u = Continuous reporting un-averaged readings disabled.

5-6 Carriage return (0x0d), Line feed (0x0a).

An example response is:
YrCpu

01234
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8.7 Setting Interval reporting parameters

8.7 Setting Interval reporting parameters

For firmware feature ≥13, the SQM-LU-DL is capable of sending timed interval reports. Each interval report is the
same as the reading request report except that the serial number (feature ≥14) is attached at the end so that numerous
reporting SQM-LU-DLs can be distinguished from each other.

The format of the interval report is shown in table 8.37:

Table 8.37: Interval report

Column Example value Description

0 r Indicates that a reading is being returned.

2-8 06.70m Reading in magnitudes per square arc second.
Leading space for positive value.
Leading negative sign (-) for negative value.
A reading of 0.00m means that the light at the sensor has reached
the upper brightness limit of the unit.

10-21 0000022921Hz Frequency of sensor in Hz.

23-33 0000000020c Period of sensor in counts, counts occur at a rate of 460.8 kHz
(14.7456MHz/32).

35-46 0000000.000s Period of sensor in seconds with millisecond resolution.

48-54 039.4C Temperature measured at light sensor in degrees C.
Leading space for positive value.
Leading negative sign (-) for negative value.

55-63 00000413 Serial number (8 digits). Each unit has its own unique serial num-
ber.

64-65 Carriage return (0x0d), Line feed (0x0a).

An example is:

r, 06.70m,0000022921Hz,0000000020c,0000000.000s, 039.4C,00000413

0123456789 123456789 123456789 123456789 123456789 123456789 12345

8.7.1 Interval reporting period setting

Executing the command “P##########x” (note upper case “P”) sets the period of the timed interval reports to the
EEPROM and RAM for booting and immediate use.

Executing the command “p##########x” (note lower case “p”) sets the period of the timed interval reports to RAM
only for immediate use.

The units are seconds. For example, the command “p0000000360x” sets the reporting time to once every 360 seconds.

8.7.2 Threshold setting for interval reporting

Executing the command “T########.##x” (note upper case “T”) sets the threshold of the timed interval reports to
EEPROM and RAM for boot and immediate use.

Executing the command “t########.##x” (note lower case “t”) sets the threshold of the timed interval reports to
RAM for immediate use only.

The units are magnitudes
arcsecond2 . For example, t00000016.00x limits reporting to values only over 16.00 magnitudes

arcsecond2
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8 Commands and responses

8.7.3 Interval setting response

Either making the request “Ix” (note upper case “I”) or any request to set the interval report setting produces the
following response shown in table 8.38:

Table 8.38: Response of viewing or setting interval reporting parameters

Column Example value Description

0 I Interval settings from EEPROM and RAM are being returned.

2-12 0000000360s Interval period that was set into EEPROM.

14-24 0000300360s Interval period that was set into RAM.

26-37 00000017.60m Threshold value that was set into EEPROM.

39-50 00000017.60m Threshold value that was set into RAM.

51-52 Carriage return (0x0d), Line feed (0x0a).

An example response is:
I,0000000360s,0000000360s,00000017.60m,00000017.60m

0123456789 123456789 123456789 123456789 123456789 12
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8.8 Simulation commands

8.8 Simulation commands

The following simulation commands help to determine the results of mag
arcsec2 readings derived from the light and temperature

sensors.
When using the Simulation mode of the SQM-LU-DL, make sure that nothing else interrupts the sequence of readings

such as external programs reading from the SQM-LU-DL, or settings of Interval reporting inside the SQM-LU-DL.
To read the internal simulation values, issue the “sx” command, the response is shown in table 8.39:

Table 8.39: Response of request for internal simulation values

Column Example value Description

0 s Confirmation of the command.

1 , Separation character.

2-12 0000000360c Number of counts.

13 , Separation character.

14-24 0000000360f Frequency in Hz.

25 , Separation character.

26-37 0000000244t Temperature ADC value as seen by the CPU. See Equation 8.1 .

38-39 Carriage return (0x0d), Line feed (0x0a).

An example response is:
s,0000000360c,0000000360f,0000000360t

0123456789 123456789 123456789 12345678

To convert raw temperature value to degrees C:

DegC =
raw×3.3

1024 − 0.5

0.01
(8.1)

To convert degrees C value to raw temperature:

raw =
(DegC × 0.01 + 0.5)× 1024

3.3
(8.2)

To set the internal simulation values and read the calculated response, issue the “S...x” command as detailed in Table
8.40. The result of that command is shown in Table 8.41.

Table 8.40: Request simulation (S....x)

Column Example value Description

0-1 S, Initiation of Sx command.

2-11 0000000360 Simulated counts.

12 , Separation character (can be anything except x).

13-22 0000000360 Simulated Frequency in Hz

23 , Separation character (can be anything except x).

24-33 00244 Simulated Temperature ADC value. See Equation 8.1 .

34 x Terminating character.
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An example command is:
S,0000000360,0000000360,0000000360x

0123456789 123456789 123456789 1234

Table 8.41: Response of setting simulation values (S...x)

Column Example value Description

0-1 S, Confirmation of S...x command.

2-13 0000094000c, Simulated counts.

14-25 0000000000f, Simulated frequency in Hz.

26-37 0000000245t, Simulated temperature ADC value. See Equation 8.1 .

38-39 r, Beginning of calculated readings.

40-47 18.04m, Calculated mag
arcsec2 .

48-60 0000000000Hz, Frequency used for calculation.

61-72 0000094000c, Counts used for calculation.

73-85 0000000.204s, Calculated period from counts.

86-92 029.0C Temperature used for calculation.

93-94 Carriage return (0x0d), Line feed (0x0a).

An example response is:
S,0000094000c,0000000000f,0000000245t,r, 18.04m,0000000000Hz,0000094000c,0000000.204s, 029.0C

0123456789 123456789 123456789 123456789 123456789 123456789 123456789 123456789 123456789 1234
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9 Installation

The SQM-LU-DL uses an internal voltage-regulator to bring the incoming USB 5VDC voltage from the PC down to
3.3VDC. The 5V USB voltage is measured and logged during data-logging operation.

The battery adapter uses an in-line-mounted voltage-regulator to bring the 9VDC down to 5VDC.

9.1 Mechanical installation

Unihedron sells an enclosure that is suitable for mounting either the SQM-LE, SQM-LU, SQM-LR, SQM-LU-DL into.
You can read more about it, including plans to build your own at www.unihedron.com/projects/sqmhousing/ .

Figure 9.1: Housing

9.1.1 Cover selection

If the unit is to be mounted in exposed location, we recommend the Unihedron plastic weatherproof housing with glass
window plate, or an acrylic dome. Acrylic domes will last 2-3 years but eventually weather on the surface. It is not clear
that this will affect the reading much. The best test would be to swap a weathered and new one back and forth when
changing one out. Presumably the main consideration would be to keep the domes clean every so often and to make sure
that the mounting plane is painted black to that it doesn’t reflect light back to the inside of the dome and then back into
the meter.

Source of scrylic domes: www.globalplastics.ca/domes.htm

9.1.2 Cover calibration

Since the meter is not weather-proof, it must be protected in some way from the elements. The Unihedron meter housing
or a plastic dome is recommended. This will reduce the incoming light (approximately 15-20%).

Because a covering will reduce the incoming light, the resultant reading will be darker (higher mag
arcsec2 value). The offset

determined by a simple light experiment should be subtracted from the reading.
Apply this subtraction offset as a negative value, i.e. if you measured 16.60 outside the covering, then 16.75 under the

dome, then an offset of -0.15 should be applied to all readings.
An example using the UDM software; if your offset is -0.12 and your factory calibrated light calibration offset is 19.92

then you should change the light-calibration-offset on the calibration-tab to 19.80. European users will see and use a
comma instead of a decimal point.
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9 Installation

Figure 9.2: Example cover calibration

9.1.3 Cover maintenance

Keep the covering clean of dust, water, ice, and bird droppings.

84 Unihedron SQM-LU-DL Operator’s Manual - 20190611



10 Default settings

The SQM-LU-DL contains an FTDI USB interface module.
The FTDI interface has not been altered from its default. There should be no reason to alter the FTDI chip settings.

The baud rate is defined by the VCP driver side when a terminal program connects to the SQM-LU-DL.
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11 Firmware upgrade

See the UDM “Firmware tab” section on page 48 for instructions on updating the firmware in the SQM-LU-DL.

11.1 Details

The SQM-LU-DL contains a micro-controller that is equipped with a boot-loader mechanism which is enabled for a few
seconds after reboot/reset.

Intel hex strings sent to the unit are used to overwrite program memory. The following link contains a thorough
description of the Intel Hex format: http://en.wikipedia.org/wiki/.hex

The basic requirements for firmware uploading are:

1. Reset micro-controller by sending the hex character 0x19

2. Within a few seconds, send the first Intel hex record. The colon “:” character indicates the beginning of an Intel
Hex record.

3. Wait for a response of “Ok” followed by “CR LF” which indicates that the record was processed properly.

4. Continue sending records and waiting for the acknowledgement.

5. The unit will reset on its own when no more records have been sent for a few seconds.

86

http://en.wikipedia.org/wiki/.hex


12 Calibration

The SQM-LU-DL is factory calibrated and a sheet of the calibration values was provided with the unit. Contact Unihedron
with your unit’s USB S/N if you need a copy of the original calibration sheet.

Some possible reasons for recalibration are:

1. A new covering/housing is being used besides the small case that the unit was shipped with.

2. A regular maintenance program is desired. There is no great need for this as the SQM-LU-DL has no analog
components.

3. Compensation for aged housing, if a plastic dome is used that might have degraded over time.

4. Replaced lens or changed field of view for experimental reasons.

12.1 Recalibration

There is no easy way to perform in-field recalibration. It is recommended to send the unit back to Unihedron for proper
calibration. There is a nominal fee for recalibration and shipping. Please contact Unihedron for details.

12.2 Light calibration

The sensor must have a reference point for an amount of light against the signal produced. It is not recommended that
this be done after factory calibration and relied upon since an improper setup will result in non-standard results.

A fluorescent light or green LED is used to simulate the spectrum that the meter would see during the night sky. A
light meter is used to adjust the light reading to 13.5 fc at the place of the SQM-LU-DL. The light calibration routine
inside the SQM-LU-DL expects to see this value.

The light that the SQM-LU-DL and light meter see must be coming from an evenly lit surface.
The “light calibration” command can be sent to the unlocked SQM-LU-DL to set the calibration value.

12.3 Dark calibration

The optical sensor in the SQM-LU-DL produces a reading even when totally dark. This “dark level” reading must be
determined so that the meter can compensate for it.

The method of dark calibration is simply to prevent any light from entering the meter then execute a “dark calibration”
command to the unit. A darkroom bag is one way to prevent light from entering the unit.

The optical sensor provides timed pulses depending on the amount of light entering. In a dark environment the pulses
will be long. The meter has a timeout of 300 seconds, so the dark calibration will take at least 5 minutes (300 seconds)
to perform.

Place the unit in a dark environment and monitor the timed readings (rx reading request) until they are consistent,
normally the value is in the 80-300 second range, then execute the “dark calibration” command.

12.4 Confirmation

Once the calibration has been done, you should be able to get a light reading from the unit at the calibration light level
of the same value as the value printed on your calibration sheet in the “Calibration offset” field, Normally this field has
a value of 8.71 mags/arcsec2.
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13 Troubleshooting

Table 13.1: Reading seem too bright

Problem The meter reads values that are brighter than expected.

Cause The IR filter may have fallen out of the lens.

Solution Ensure that there are no extra sources of visible light in the field of view of the meter.
Inspect lens for IR filter. You should see a light blue colour inside the lens.

Table 13.2: Reading is 0.00mpsas

Problem The meter reads values of 0mpsas.

Cause In bright light over about 6mpsas (even indoors) the meter saturates and will produce a reading
of 0mpsas.

Solution Test the meter in a darker setting or place a cover over the meter while doing indoor testing.
Note: in complete darkness (like a photo-darkroom), the meter may timeout and also produce
strange readings.

Table 13.3: Cannot Find UDM software

Problem Microsoft Edge cannot find UDM software on the CD. Error “Can’t reach this page”.

Cause Microsoft Edge has protections in place to hide file lists on remote drives.

Solution Use the File Manager to navigate the CD to the Windows directory then install from there. Or,
get the latest Windows version of UDM from the Unihedron website:
unihedron.com/projects/darksky/cd/Windows/

Table 13.4: Driver not found

Problem USB driver not found

Cause Some operating systems may not have the FTDI VCP USB driver installed by default.

Solution You can get the most updated driver for your operating system from FTDIchip.com here: http:

//ftdichip.com/Drivers/VCP.htm

Table 13.5: USB device not found, or more than one device on the same COM port

Problem USB device not found, or more than one device on the same COM port

Cause Faulty USB software driver, or faulty USB hardware port on computer

Table continued on next page ...
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Table 13.5 – continued from previous page

Solution

• Try the meter on another USB port on the computer. Sometimes certain USB ports do not
work for various software or hardware reasons.

• Ensure that the latest FTDI USB VCP driver is installed, you can check the version number
from FTDIchip.com here: http://ftdichip.com/Drivers/VCP.htm

• Use the UDM software to identify found devices. The SQM-LU-DL device has a serial number
prefix of FT...... This may help identify what the other device is.

• Remove any other USB devices attached to the system to troubleshoot this problem.

• Try to reassign the SQM-LU-DL to another COM port using the Windows Device Manager.
For example, it the SQM-LU-DL is assigned to COM1, then try to assign it to a free COM
port number.

Table 13.6: LED does not light up

Problem LED does not come on initially when battery pack is connected

Cause Sometimes the battery contacts become oxidized which prevents the proper voltage from reaching
the meter.

Solution Clean the battery contacts by rolling the batteries with your thumb while they are in the holder.
This will scrape off the oxide buildup.

Table 13.7: Recording stops

Problem The meter stops recording while connected to the computer

Cause Some computers, especially laptops, have the “USB suspend mode” activated which puts the USB
port to sleep when there is not enough activity on the computer.

Solution The USB sleep issue can be corrected by ensuring that your power settings do not put the USB
ports to sleep when the computer is inactive. This can be true for any operating system. In
Windows, the Windows Control panel procedure to disable the USB suspend setting is located
here:
Start
Control Panel
Hardware and Sound
Power Options
Edit Power Plan Settings

Put the computer to sleep while plugged in = Never
Change advanced power settings
USB Settings
USB selective suspend setting
Plugged in = Disabled
OK
Save changes
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13 Troubleshooting

Table 13.8: Meter cannot be found on battery or by PC

Problem Meter cannot be found, or stops working intermittently when connected to battery or computer.

Cause Faulty FTDI USB module inside meter.

Solution There is not much that can be done to correct this aside from replacement. However, the following
test usually reliably proves the issue. While connected to the computer using UDM, run the unit
in “Log continuous” mode at 1 second sampling for at least 1000 samples. If there are any missed
readings, the “records missed” counter on the screen will increment and show Red. The test
procedure is as follows:

1. Start UDM and select the device.

2. Press the “Reading” button to test connectivity.

3. Press the “Log continuous” button.

4. Select “Every x seconds”.

5. Enter 1 into the s box to the right of the selection.

6. Press “Record”.

7. Let this run for at least 1000 records and watch that are no “Records missed”.

Table 13.9: Meter cannot be found by Windows operating system

Problem The windows computer cannot identify the SQM-LU-DL, and re-installing the FTDI device drivers
does not help.

Cause The Windows FTDI driver installation may be storing old attempts at installing drivers that should
have been cleared out.

Solution The following steps can be used to clean up the FTDI entries in Windows:

1. Install this FTDI “CDM Uninstaller” utility at:
www.ftdichip.com/Support/Utilities/CDMUninstaller v1.4.zip

2. The detailed instructions for its operation are here:
www.ftdichip.com/Support/Utilities/CDM Uninst GUI Readme.html

3. Here is a quick summary of the instructions:

4. Start up the CDM uninstaller program

5. Press - Add

6. Press - Remove devices

7. Wait 5 minutes or so until complete

8. Close

9. Re-insert SQM-LU device

10. Wait 5 minutes or so for Windows to install driver and port
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Table 13.10: Cannot get a reading

Problem Cannot get a reading

Cause Driver is not installed or the SQM-LU-DL is not connected

Solution For Windows, check that the unit is registered using the registry editor from the Start menu, select
Run, then type in regedit and press OK.
For Windows XP and Windows 2000, look here for your device

HKEY LOCAL MACHINE\
SYSTEM\

Enum\
FTDIBUS\

VID 0403+PID 6001+Serial Number\
0000\

PortName

For Windows 98 and Windows ME, look here for your device
HKEY LOCAL MACHINE\

SYSTEM\
Enum\

FTDIBUS\
VID 0403+PID 6001+Serial Number\

0000\
PortName

The Serial Number is printed on the bottom of the unit.
The above will identify which COM port the SQM-LU-DL has been assigned.
If the SQM-LU-DL is plugged in, the active COM port will show up in this list:

HK LOCAL MACHINE\
HARDWARE\

DEVICEMAP\
SERIALCOMM

For Linux and Mac, use lshal to determine which device the FTDI driver has attached the SQM-
LU-DL to. The CD contains a Perl script findftdi.pl to filter out the lshal output.
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14 Glossary

Table 14.1: Glossary of terms

ADC Analog to Digital Converter. A device usde to convert an analog signal into a digital value.

CCD Charge coupled device is a type if image sensor.

EEPROM Electrically Erasable Programmable Read Only Memory is a type of memory that retains its
contents after the power has been removed. This type of memory has a limited write/erase
cycle as well as a lifetime for data retention. In the SQM-LU-DL, the parameters in the micro-
controller can be written 1 million times and last for 100 years.

Firmware The program that resides inside the device. In the case of the Unihedron SQM products, it is
the software runs the device including reading and reporting the light values.

FITS Flexible Image Transport System is an open standard defining a digital file format useful for
storage, transmission and processing of scientific and other images.

FTDI Future Technology Devices International is the manufacturer of the USB module inside the
SQM-LU-DL. FTDI also supplies the VCP software driver for the computer operating system
so that the SQM-LU-DL can communicate with the computer.

GPS Global Positioning System. A GPS receiver may be connected to a computer to allow UDM to
integrate the location information into the logged data. See UDM for mode details.

mpsas Magnitudes per square arcsecond. The unit of measurement reported by the SQM.

NMEA National Marine Electronics Association data format that the GPS receiver produces.

RAM Random Access Memory. Temporary memory that only retains data while power is applied.

RTC Real Time Clock. A circuit that is used to keep “real time” data like date/time. Computations
for leap year and weekday are performed in this circuit.

SQM-LU-DL Sky Quality Meter with Lens and USB connectivity, and with datalogging capabilities.

Supercap A very large capacitor in the order of Farads. The SQM-LU-DL uses a supercap to keep the
RTC running when the meter is not connected to any external power supply. The advantage of
this component no internal battery must be regularly replaced.
The disadvantage is that the capacitor must be occassionally charged up before using the meter
for external battery assisted datalogging. When fully charged (a few hours), the capacitor will
last for weeks.

UDM Unihedron Device Manager is software used to access the SQM series of meters.

USB Universal Serial Bus

UTC Coordinated Universal Time is the primary time standard by which the world regulates clocks
and time.

VCP Virtual COM port (VCP) drivers cause the USB device to appear as an additional COM port
available to the PC. Application software can access the USB device in the same way as it would
access a standard COM port. The SQM-LU-DL requires the FTDI VCP driver be installed on
the computer operating system so that communications can be done with the meter.
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